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1     Safety Information
1 Safety Information

Before starting installation, setting up, operation and before 
maintenance work is carried out, it is essential to read and follow 
the appropriate warning and safety information given in this 
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for 
the relevant module or device.

1.1 Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring 
assembly and production processes. Transducers (sensors) for 
the acquisition of physical quantities such as voltage, current, 
resistance, temperature, force, displacement, torque, mass, 
strain and pressure can be connected. The modules are used 
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall 
within the intended use of the modules.

To ensure safe operation the modules and devices must only be 
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed.

1.2 Checking for damage in transit

On receipt of the goods visually check that the packaging and the 
module or device together with the data medium are intact. Also 
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in 
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case 
contact your customer consultant or Gantner Instruments GmbH.

1.3 Personnel

The installation, operation and maintenance of the modules or 
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education 
have sufficient knowledge in the required field and are familiar 
with the relevant national occupational protection regulations, 
accident prevention regulations, guidelines and accepted engi-
Q.series
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1     Safety Information
neering rules. They must be able to reliably assess the results of 
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

• the national installation and erection regulations (e.g. ÖVE, 
VDE, etc.)

• generally accepted engineering rules

• the details on transport, installation, operation, servicing, 
maintenance and disposal in this manual.

• the parameters, limits and the details about the operating and 
ambient conditions on the name-plates and in the data sheets.

1.4 Special risks

The modules A123, A124, A127 and A128 are specifically 
intended for measurements at high voltages. Consequently, on 
the modules a voltage of up to 1200 V may be present, which can 
lead to fatal or severe injury on touching the terminal contacts or 
bare parts of the connecting cables. Therefore, make sure that 
only qualified personnel have access to the modules or devices 
and that the voltages on modules can be switched off by a switch-
disconnector or similar device for service purposes.

1.5 Siting locations

The devices in the Q.series range are protected to IP 20 against 
water, dirt and small parts. If the ambient conditions require it, 
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the 
technical data.

1.6 Modifications

Making modifications to the modules or devices is not permitted. 
Dirt and shrouding covers may only be removed for service and 
maintenance purposes.

1.7 Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may 
only take place in the voltage-free state. Therefore follow the 
points below:

• Before cleaning, disconnect all connectors.
Vers. No. 1.5
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1     Safety Information
• Clean the housing with a soft, slightly moistened cloth. Never 
use any solvents, because these may attack the labels.

• When cleaning, make sure that no liquid enters into the 
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are 
defective, have developed a fault or are damaged. In this case it 
is essential to contact your customer consultant or Gantner 
Instruments GmbH.

1.8 Disposal

Old devices which are no longer usable must be disposed of 
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The 
packaging can be recycled and should therefore be passed into 
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can 
pack faulty devices or modules properly.

1.9 General hazards due to non-observance of the 
safety information

The modules or devices conform to the state of the art and are 
operationally safe. However residual risks may arise when they 
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have 
read and understood the operating manual and in particular the 
information relating to safety.
Q.series
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2     Labels and warning information
2 Labels and warning infor-
mation

2.1 Warning information

To prevent damage to property it is essential that you follow the 
warning information given in this operating manual.

Indicates a situation in which the consequence may be property 
damage if the information is not followed.

2.2 Labels on the modules

Symbol: 

Meaning: This symbol is the CE marking. This shows that we 
guarantee that our product meets the requirements of the rele-
vant EC directives.

2.3 Labels in this manual

To simplify reading this manual we use the following labels and 
notation:

IMPORTANT
Paragraphs with this symbol give important information about 
the product or about using the product.

Tip
Contains application hints and other particularly useful informa-
tion.

italics signifies highlighted text

interface signifies entries and entry fields in program 
user interfaces

Options indicates menu items in the program user 
interfaces

> signifies a sequence of menu items, e.g. in 
Options > Settings

➡ indicates special features or restrictions
Q.series
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3 Introduction
 Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner 
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

The manual is included in the items supplied. Keep the manual 
safe or download the latest version from our web site. If you find 
faults on the product or errors in the accompanying documenta-
tion or if you have suggestions for improvement, please contact 
your customer consultant or Gantner Instruments GmbH directly. 
We would be glad to receive your comments and ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
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3     Introduction
3.1 The documentation of the Q.station

The documentation for the Q.station consists of this manual. A 
further manual is obtainable for the modules to be connected to 
the Q.station.

You will find this manual also as a PDF file on our home page 
www.gantner-instruments.com and on the Gantner CD enclosed 
with your Q.station 101 or which you can order free of charge 
from Gantner Instruments GmbH.

3.2 About this manual

This manual describes the installation, operation and configura-
tion of the Q.station using the test.commander program. The pro-
gramming of the Q.station 101 with the test.con program is 
described in a separate manual.

The manual is divided into several chapters:

• Safety information in Chapter 1, page 7ff.

• A description of the labels and symbols used on the Q.station 
and in this documentation can be found in Chapter 2, 
page 11ff.

• An overview, showing a complete system (including modules) 
and which variants are available, can be found in the next sec-
tion.

• The description of the terminal assignments on the inputs and 
outputs can be found in Chapter 4, Operation and displays, 
page 17ff.

• Chapter 5, Q.station 101 connection, describes how you 
establish the connection to a PC, how you synchronize several 
Test Controllers and how you carry out a firmware update 
when required (page 25ff.).

• The basic configuration of your system, which settings you 
have to make via the test.commander program so that you can 
carry out measurements, is explained in Chapter 6, Basic con-
figuration of your system, page 41ff.).

• The settings for recording data using one of the integrated 
data loggers as well as examples of logger configuration are 
included in Chapter 7, Recording with the data logger, 
page 75ff.

• Chapter 8, Access to data in the Q.station, describes how you 
can remotely access the data on your Q.station (page 103ff.).
Vers. No. 1.5
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3.3 System description

The modules in the Q.series have been developed for industrial 
and experimental measurement and test engineering, in particu-
lar for multi-channel measurements of electrical, mechanical and 
thermal signals on engine and component test-rigs as well as for 
monitoring processes and long-term supervision. 

The individual modules can be combined with the Q.station 101 
to form one system as required. You can connect up 64 modules 
to a Test Controller Q.station and then address them from a PC or 
PLC via a single interface.

The Q.station 101 is obtainable in four variants:

All variants are described in this documentation. The sections on 
the display are not relevant for the variants without a D. 

Application of the Q.station 101

The Q.station Test Controller is a programmable module with 
1 Gbyte of RAM and an internal hard disk of which 1 Gbyte is 
available for data storage using logger functions. The Test Con-
troller can be configured and programmed over wide ranges and 
also offers a graphical display. Optionally, you have EtherCAT 
slave, standard Ethernet with 1 Gbyte/s, USB interfaces, CAN bus 
and a web server available.

You can connect up to 16 measurement modules to each of the 
four serial interfaces (UARTs) of the Q.station Test Controller 
(Fig. 3-1, page 16). This means that 8 channels can be acquired 
at 100 kHz sample rate, 2 per each UART.

Type
VGA display 

480 x 640, touch 
screen

Optional 
versions

PAC, graphically pro-
grammable with test.con, 

HMI Designer

Q.station 101 – with DVI output –

Q.station 101 T – with DVI output X

Q.station 101 D X – –

Q.station 101 DT X – X
Q.series
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Fig. 3-1 Q.station 101 with up to 64 modules.

UART data throughput at 24 MBaud

Sample rate 10 kHz

Sample rate 100 kHz

32 channels

2 channels

Ethernet data throughput (transmission rate with 
block transfer)

512 real variables (10 kHz)

32 real variables (100 kHz)

EtherCAT data throughput (transmission rate)
Read 253 values and write 253 values at 

10 kHz, cycle time ≥ 100 μs

Interfaces
Ethernet, EtherCAT, 4x UART, 1x CAN bus, 
SD card, 2x USB 2.0 with up to 4 Mbyte/s

Max. number of slaves 64

…

…

…

…

max. 16 modules per UART
Vers. No. 1.5
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4     Operation and displays → Mounting
4 Operation and displays

This chapter contains the description of the connections (pin 
assignments), of the LED indicators and the functional operation 
of the LCD displays (optional component).

4.1 Mounting

The Q.station Test Controller can be directly plugged onto a 
mounting rail (35 mm DIN rail according to DIN EN 60715).

4.2 Terminal assignment

The Q.station 101 offers you eight digital inputs and four digital 
outputs, one CAN bus interface, two USB 2.0 interfaces and the 
possibility of inserting an SD card as storage expansion. The con-
nector strips for the digital inputs/outputs and the power supply 
are divided up into two 10-pole plugs (Fig. 4-2).

Fig. 4-1 Terminal arrangement on the Q.station 101 (top).

IMPORTANT
When accessing the Q.station 101 by FTP, USB1 is displayed as 
USB0 and USB2 as USB1.

Fig. 4-2 Terminal arrangement on the Q.station 101 (bottom).
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CAN bus
CAN bus pin assignment Meaning

CAN 1 H CAN1 High

CAN 1 L CAN1 Low

CAN 2 H Not yet available

CAN 2 L Not yet available

Fig. 4-3 Terminal assignment of the plug-in terminal for the CAN 
bus of the Q.station 101 Test Controller.

We recommend only using screened CAN bus cables and that the 
screen is connected flat on the control cabinet frame.

UARTs
Pin assignment of Q.station 101 UARTs

UART 1 B (B1)
Max. 16 modules

UART 1 A (A1)

UART 2 B (B2)
Max. 16 modules

UART 2 A (A2)

UART 3 B (B3)
Max. 16 modules

UART 3 A (A3)

UART 4 B (B4)
Max. 16 modules

UART 4 A (A4)

Sync B (SyB) Input/output for synchronization, e.g. with 
another Test ControllerSync A (SyA)

Fig. 4-4 Terminal assignment of the plug-in terminal for the 
UARTs of the Q.station 101 Test Controller; refer to Fig. 4-
2 for the position of the connector strip.

The connection of the Q.bloxx modules is described in the Q.bloxx 
manual.

Digital inputs
Digital input plug assignment

+5 V auxiliary voltage for digital inputs

DI1

DI2

DI3

DI4

DI5
Vers. No. 1.5
18 Released: 15/10/2018



4     Operation and displays → Terminal assignment
Fig. 4-5 Terminal assignment of the plug-in terminal for the digital 
inputs of the Q.station 101 Test Controller.

You can freely assign the digital inputs using the test.commander 
(Section 6.3, page 55). The DIO1 input must be used if you want 
to set up synchronization through IRIG-B and digital inputs. You 
can select the input level in the test.commander between TTL 
(switching level <1 V and >3.5 V) and PLC (switching level <7 V 
and > 8 V) (Settings > General remarks > Digital input 
switching threshold; refer to Section 6.1.1, page 43).

Digital outputs and power 

supply
Pin assignment for digital output and power

+UH (Power supply, max. 30 VDC, 100 mA) / Live signal

DO1 Live signal

DO2 Control, freely selectable

DO3 Control, freely selectable

DO4 Control, freely selectable

OH (Digital output 0 V)

Supply +10 to 30 VDC Both terminals are connected 
together internallySupply +10 to 30 VDC

0 V Both terminals are connected 
together internally0 V

Fig. 4-6 Terminal assignment of the plug-in terminal for the digital 
outputs and the power supply of the Q.station 101 Test 
Controller.

The Live signal (life sign; refer to Section 6.1.1.2, page 44) is 
present either as a TTL level between +UH and OH or – if a volt-
age >5 V is applied between these terminals – it is output with 
this voltage as a voltage excursion on DO1. You can freely assign 
the digital outputs of the Q.station 101 Test Controller using the 
test.commander (Section 6.3, page 55).

The terminals for the power supply are provided doubled so that 
you can in each case use just one or both terminals.

DI6

DI7

DI8

Digital input 0 V, GND

Digital input plug assignment
Q.series
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Tip
Use the doubled terminals, for example, to link the supply voltage 
from here to the connected modules.

An unregulated direct voltage between 10 and 30 volts is needed 
for the power supply. The Q.station 101 needs approx. 12 W of 
available power. The power required is almost constant over the 
complete voltage range.

4.3 Interfaces, SD card

4.3.1 Ethernet connection

The Ethernet sockets use the standard pin assignment and you 
can directly insert standard Ethernet cable (RJ45). Cross cables 
are not needed and, if required, the switchover takes place auto-
matically in the Q.station 101.

We recommend the use of cables to category Cat-5 or better.

4.3.2 USB connection

The pin assignment of the USB sockets is as usual, so you can 
directly insert appropriate USB memory sticks. The memory 
sticks must be formatted with ext3 or FAT32; other formats, e.g. 
NTFS, are not allowed.

The interface can be loaded with up to 100 mA. Use a separate 
power supply for devices with a higher current requirement (also 
start-up current), e.g. external hard disks.

The maximum transfer rate is approx. 4 Mbyte/s where this is 
supported by the connected memory device.

4.3.3 SD card

You can use all commercially available standard SD cards which 
are formatted with ext3 or FAT32.

➡ We recommend SDHC cards Class 10 from SanDisk or PNY with 
a writing speed of more than 30 MB per second, e.g. the 16 GB 
card from PNY with a data rate of up to 100 MB per second. Note 
that the speed stated on the cards is only the peak speed. The fig-
ure says nothing about the continuous transfer rate, i.e. whether 
you can save with this speed over a longer time period. Also, the 
speeds for reading and writing (usually lower) are often stated 
separately.
Vers. No. 1.5
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4.4 LED flashing frequency

4.4.1 Flashing frequency of the Q.station 101

4.4.1.1 No error, everything OK

The blue LED (RUN) lights permanently, the orange LED (ERR) is 
off.

4.4.1.2 Storage to external memory running

The blue LED flashes quickly. You can remove the storage 
medium, e.g. a USB stick, when the flashing stops.

4.4.1.3 Error

The blue LED lights permanently and the orange LED flashes 
(one flash with a pause in each case).

Read out the error status via the test.commander; refer to 
Section 6.5.4, Reading status information on page 71.

4.4.1.4 Firmware error

The orange LED lights permanently: The firmware could not be 
loaded.
The blue LED is off permanently: The FPGA cannot start the firm-
ware.

Try a restart. If this does not help, please contact our Support. In 
most cases the system can be reset by a service script which is 
located in the subfolder Additional of the installation directory. 
Copy the script to a USB memory stick which you insert before 
switching the Q.station on.

➡ Both the orange and the blue LEDs may light continuously. If this 
occurs for longer than about two minutes, the firmware update 
could fail. Try to carry out the update again or contact our Sup-
port.

4.4.2 Module flashing frequency

The modules have three LEDs: one blue LED on the upper edge 
and one red LED per connector strip. In normal operation the 
blue LED lights, but the red LEDs do not light. Depending on the 
error, the LED of the affected connector strip or the blue LED 
lights or all LEDs flash in a certain order. In the following illustra-
tions a short dash corresponds to short flash and a long dash to a 
long flash.
Q.series
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4.4.2.1 SOS, configuration error

Fig. 4-7 Flashing sequence with an incorrect module or when 
there are no settings in the base.

Cause: The configuration saved in the base does not match that in 
the module.

There may be two reasons for this:

1. There is no configuration in the base yet.

2. The module type saved in the base configuration differs from 
the plugged-in module, therefore the configuration cannot be 
accepted.

Consequently, either change the module for the correct module 
type or reconfigure the module (Chapter 6, Basic configuration of 
your system, page 41). The (new) configuration is then automati-
cally saved in the base.

4.4.2.2 Firmware download

Fig. 4-8 Flashing sequence on downloading the module firmware.

The LEDs flash while the firmware download into the module is 
taking place.

4.4.2.3 Activating the firmware download

Fig. 4-9 Flashing sequence on activating the firmware.

The LEDs flash while the firmware is being configured after a 
download. After the download the module must be restarted.

4.4.2.4 Problems during data transmission

Fig. 4-10 Flashing sequence for problems during the data transmis-
sion.

blue LED
red LED 1
red LED 2

blue LED
red LED 1
red LED 2

blue LED
red LED 1
red LED 2

or
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4     Operation and displays → LCD screen
These flashing sequences indicate a problem with the communi-
cation. Check the following:

1. Is the interface link between the modules in order (are the 
bases plugged together or connected to the cables correctly)?

2. Is the interface link between the modules and the Test Con-
troller in order?

3. Is wiring of the interface connections correct?

Then restart the system (by switching off, waiting one minute and 
then switching on again). If these measures do not remedy the 
error, then contact your customer consultant or Gantner 
Instruments GmbH directly.

4.4.2.5 LED displays in normal operation

For modules with analog inputs a red illuminated LED indicates 
that the measurement range has been exceeded on at least one 
input. You can suppress this indication in the module configura-
tion.

For modules with digital inputs or outputs an orange illuminated 
LED indicates that an input or output is active.

4.5 LCD screen

The capacitive touch screen can be operated by directly tapping 
the required option.
Q.series
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Fig. 4-11 Q.station 101 start screen.

In the factory setting there are five different tiles:

• Controller with information on the type, serial number and 
firmware version. Tap on the tile to show further data, e.g. the 
active channels and their measurements.

• A tile for test.con. If displays have been defined in this pro-
gram, they can be seen here or on the following screens.

• I/O modules with the number and type of the connected or 
found modules. Tap on the tile to call the overview and to 
select individual modules or channels for display (also as 
graphs).

• A tile for the display of data, e.g. as a graph.

• Network with the settings for the network interface. Tap on 
the tile to show also the subnet mask and gateway address or 
to be able to change the settings.

Via test.con you can define further tiles or modify the display.
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5     Q.station 101 connection → Connect Q.station to Ethernet network with server
5 Q.station 101 connection

This chapter contains the description of how you connect the 
Q.station 101 to a PC.

Refer to the Q.bloxx manual for connection of the Q.bloxx mod-
ules.

If you are using one of the versions Q.station 101 D or Q.station 
101 DT, you can enter the IP address via the display. Otherwise 
you must first establish communication once only with the 
Q.station 101 via the test.commander program. This can take 
place via a fixed IP address or the automatic address allocation 
(DHCP). If necessary, you can then allocate a fixed address for 
further operation to the Test Controller; refer to Section 6.1.3.2, 
page 48.

5.1 Connect Q.station to Ethernet network with 
server

In the factory setting the Test Controller Q.station 101 uses 
DHCP (Dynamic Host Configuration Protocol), i.e. it receives a 
valid network address from a server which is present in the net-
work. If you connect the PC to an Ethernet switch, an IP address 
is automatically allocated and you can establish the connection 
via test.commander.

Tip
We recommend the use of industrial Ethernet switches. The 
Q.station 101 uses autonegotiation and operates, if available, 
with 1000 Mbit/s and full duplex for the transmission.

5.2 Connect Q.station to an Ethernet interface

If you are not connected to a network or if no server is located in 
the network, you have the following options:

1. You use a fixed address from the range 192.168.1.x for your 
PC. In principle with a network you can also establish a con-
nection when the network uses a different address range. But 
it is better in these cases to establish a direct link initially and 
then to allocate an address to the Q.station 101 from the 
address range of your network.

If the Test Controller does not receive an IP address from a 
server, then it adjusts to its static IP address after a few sec-
onds. The factory setting of the static IP address is 
192.168.1.28. Therefore, set your PC, for example, to 
192.168.1.10.
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2. You use one of the versions Q.station 101 D or Q.station 101 
DT and change the address of the Q.station 101.

Tap on the tile and and enter an IP address from the address 
range of your PC in the following screen.

With the versions Q.station 101 D and Q.station 101 DT the IP 
address used (and whether DHCP is used or not) is shown in the 
display.

Fig. 5-1 Indication of the IP address in the display.

Tip
Refer also to Section 5.7, Ethernet on the PC, on page 35 for the 
display and setting of the PC IP address.

5.3 Establishing a connection

A project is created by the test.commander in the course of estab-
lishing a connection. A project contains the hardware setup, the 
sensor and I/O settings present in the modules as well as the sen-
sor signals used and computations, the so-called variables, which 
are to be output. You load this project later to be able to carry out 
settings.

Procedure 1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.6 on page 34.

2. Start the software and select Open Wizard to start …

Another program window opens.

3. Enter a name for the project.

4. Select the network adapter to which the Test Controller is 
connected.

5. Specify which network type you are using.

a) A DHCP server is available in the network used. For a 
new Test Controller activate DHCP is activated.
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b) The controller will be connected to a network without 
DHCP server or The controller will be directly connected 
to the PC.

6. Make sure that the Ethernet interface of the Test Controller is 
connected and the power supply is only switched on after con-
nection to the network or PC. Then click on Continue.

➡ If this is the first connection which you are establishing, you must 
obtain access to the network for the test.commander (requires 
administrator rights).

7. Wait until your Q.station 101 Test Controller is displayed. 
Mark the entry and click on Continue.

If the Test Controller is not shown, check the IP address in the 
display (if available). Otherwise check whether the server has 
allocated an address to the module. Also check whether the 
network cable is correctly inserted and, if necessary, whether 
the port on the switch is active. Then carry out a scan again.

8. If you are not using a network with DHCP server, you obtain a 
dialog with the possibility of allocating a fixed IP address to 
the controller. Then enter an IP address from the range of 
your network or PC.

9. Connect your modules to the UART(s) of the Q.station 101 
Test Controller, switch on the power supply for the modules 
and wait until the modules have initialized (blue LEDs flash 
briefly every two seconds). Then click on Continue.

All interfaces are searched for modules. If there are address 
conflicts, the addresses are changed appropriately, provided 
this is possible via the PC (no hardware addresses via the DIP 
switch in the base).

10. Read the configuration out again, check the variables (names) 
and, if necessary, make corrections and open the assistant 
with a click on Continue.

Finally, a window is shown in which the Test Controller and all 
modules with the values of the measuring channels can be seen 
(provided they are configured and capable of measurement in the 
standard configuration).

Once you have seen the procedure, you can also carry out all the 
settings yourself for further projects, i.e. create a new (blank) 
project and then add your Controller Online, etc.

5.4 Note on the connection of modules

5.4.1 Activating the terminating resistances

The terminating resistances must be activated on the last base of 
each interface line (and only there), because the end of the line 
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must be terminated with two resistors (termination). Otherwise 
reflections occur on the line and lead to disturbances, even to the 
loss of data transmission.

IMPORTANT
The terminating resistances may only be activated at the end 
points of the interface line. If resistances are also activated in 
between, the signal is weakened and interference or even inter-
ruption of the data transmission occurs for the modules located 
after the additional resistances.
Separate termination on the Q.station 101 is not necessary.

➡ Do not use cable which is too thin for the connection so that the 
required power can be transferred to the module without signifi-
cant losses. 

The cable diameter, which can be connected to the terminals, is 

0.14 mm2 minimum and 1.5 mm2 maximum or with wire-end 

sleeves without plastic sleeves 0.25 mm2 and 1.5 mm2 and with 

plastic sleeves between 0.25 mm2 and 0.5 mm2. In total no more 
than 16 modules should be supplied through their bases con-
nected together. With more modules another supply line is neces-
sary, for example via the Q.bloxx Extension Socket QES.

➡ The extension socket only supplies the module situated to the 
right of it and the modules located to the left of it require a power 
supply via the socket located on the far left.

5.4.2 Connecting modules to Q.station 101

The Q.station Test Controller is inserted directly onto a mounting 
rail (35 mm DIN rail according to DIN EN 60715) and connected 
to the bases via cables and plugs. If you want to exploit the maxi-
mum number of 64 modules, you must connect each of all four 
serial interfaces (UARTs) of the Q.station 101 to 16 modules. The 
sync lines are not needed for this and the synchronization takes 
place through the UART lines. In doing this, pay attention to the 
maximum line length of the individual interface cables; refer to 
the table on Section 6.1.2.1, page 44.
Vers. No. 1.5
28 Released: 15/10/2018



5     Q.station 101 connection → Synchronization of several systems
Fig. 5-2 Terminal assignment of the plug-in terminal for the 
UARTs of the Q.station 101 Test Controller; refer to Fig. 4-
2 on page 17 for the position of the connector strip.

➡ If you want to use all four interfaces, then in each case with all 
four groups you must use the connection for UART 1 on the 
socket or insert the Q.bloxx Extension Socket QES to be able to 
use the interface lines for UART 2 available on the sockets.

5.5 Synchronization of several systems

The synchronization of several interconnected Q.series modules 
is ensured by the Test Controller Q.station 101. Here, you can 
also interconnect the Q.station with other types of test controller, 
e.g. with Q.pac. With Q.gate the connection is possible optionally.

All synchronized modules operate synchronously and the maxi-
mum jitter is approx. ±0.5 μs over all modules. The synchroniza-
tion line transfers not just a clock signal, but also the date and 
time.

In each case connect SyA with SyA (SyncA) of the next module, 
SyB with SyB (SyncB) of the next module, etc.

You have various methods of obtaining synchronization, even 
with several systems, i.e. several Test Controllers; (refer also to 
Fig. 5-3 on page 31):

1. Use the time signal in the Q.station 101 Test Controllers 
based on the IRIG standard (Inter Range Instrumentation 
Group) to synchronize all other Test Controllers to one master 
controller.

Pin assignment of Q.station 101 UARTs

UART 1 B (B1)
Max. 16 modules

UART 1 A (A1)

UART 2 B (B2)
Max. 16 modules

UART 2 A (A2)

UART 3 B (B3)
Max. 16 modules

UART 3 A (A3)

UART 4 B (B4)
Max. 16 modules

UART 4 A (A4)

Sync B (SyB) Input/output for synchronization with 
another Test ControllerSync A (SyA)
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The master controller (the device which is not configured as a 
slave, refer to Section 6.1.1.3, Synchronization, page 44) uses 
its internal clock for the date/time stamp (gray path in Fig. 5-
3). For this type of synchronization (inputs SyA and SyB) you 
must lay synchronization lines between the Test Controllers; 
the maximum length of all lines together is 400 m. The master 
controller transfers the time stamp through an RS-485 link to 
the other Test Controllers. This method achieves the best 
time synchronization with the smallest jitter (approx. ±2 μs) 
between the individual modules, because the time informa-
tion passes simultaneously to all Test Controllers.

2. You connect a radio receiver for time signals, e.g. for DCF77 
which converts the received time signal to IRIG-B or AFNOR 
NF S87-500, to a Q.station Test Controller.

As master controller this then synchronizes all other Test 
Controllers using IRIG (orange colored path in Fig. 5-3) as 
with Variant 1. If it is not possible to connect the individual 
Test Controllers via synchronization lines or this is not 
desired, you can also connect a receiver to each Test Con-
troller (Variant 2b).

3. You connect an NMEA-0183 compatible GPS receiver (Global 
Positioning System) to a Q.station Test Controller, which 
then, similar to Variant 1, synchronizes as master controller 
all other Test Controllers (from firmware V1.08).

With this method the time information of the GPS signal is 
evaluated instead of a pure time signal. In addition you can 
also process the position details of the GPS receiver in the 
system and assign the measurements (light blue path in 
Fig. 5-3). If it is not possible to connect the individual Test 
Controllers via synchronization lines or this is not desired, 
you can also connect a receiver to each Test Controller (also 
to a Q.gate Test Controller) (Variant 3b).

4. You define a PC as an SNTP time server which can distribute 
the NTP time stamp to all Q.station, Q.gate or Q.pac Test Con-
trollers (dark blue path in Fig. 5-3).

5. You use EtherCAT for the synchronization of the Test Con-
troller (distributed clock).

IMPORTANT
The maximum length of the synchronization cables on SyA and 
SyB is 400 m.
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Fig. 5-3 Possible types of time synchronization.

The absolute accuracy of the time information depends on the 
method used. If you do not want to use or cannot use any time 
synchronization lines, e.g. because the spacing of the systems is 
too large, you must expect greater deviations. In the variant 2b 
the deviations lie in the range from a few milliseconds up to about 
100 milliseconds, but this depends on various factors, e.g. how 
often the time information is received. In the variant 3b the time 
accuracy of the GPS signal is decisive, which is only approx. 1 
second absolute.

The fourth method uses, for example, the SNTP protocol (Simple 
Network Time Protocol) used in the Microsoft Windows operating 
system to transfer the date and time via Ethernet. However, the 
individual Test Controllers must always query the time server in 
order to be able to synchronize their times to the time server. The 
achievable accuracy is therefore not as good as for the first three 
methods. If required, you can also set up a (full) NTP time server 
on a PC and synchronize it with a time server in the Internet. You 
will find further information about this at http://www.mein-
berg.de (here you can also download a time server program) and 
at http://www.pool.ntp.org. The time accuracy is then only depen-
dent on the change in the response times in your network.
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The fifth method receives the time signal from a EtherCAT mas-
ter. Here, the time delay of the signal is fed back to the master 
(from firmware version 1.7.2) which then calculates a new time 
signal. The time resolution of the signal is 1 μs. The start date of 
this time calculation is 1.1.2000.

If you combine several synchronization methods, the best possi-
ble one is always used from those available:

1. Hardware synchronization (synchronization of the Q.series, 
EtherCAT, IRIG-B or AFNOR using a time signal, e.g. DCF77)

2. Time signal from GPS (NMEA-0183)

3. SNTP

The configuration of the synchronization in all cases occurs via 
the test.commander program. Apart from synchronization via 
SNTP (Section 6.1.3.5, page 51) you set the type of synchroniza-
tion used via the menu Settings > Synchronization; refer to 
Section 6.1.1.3, page 44.

5.5.1 Connection of a radio receiver for time signals

The Q.station 101 can process the following time signals:

• AFNOR NF S87-500

• IRIG B003

• IRIG B005

Depending on the output signal of your receiver you basically 
have the following methods:

1. The receiver, e.g. for DCF77, is connected to the digital IOs of 
the Q.station 101 Test Controller (plug-in terminal Digital 
Input, connections DI1 and GND; refer to Section 4.2, 
page 17f). The variant is suitable if the receiver outputs sig-
nals at a TTL level. This is the case, for example, with Hopf 
clocks (IRIG-B003 or IRIG-B005 depending on type) with TTL 
output (e.g. module 4465 with interface version 5).

2. The receiver is connected through the sync input (plug-in ter-
minal UART, connections SyA and SyB; refer to Section 4.2, 
page 17f). The variant is only possible when the receiver has 
an RS-485 interface, because the sync input uses this inter-
face.

With Settings > Synchronization, specify which variant you 
are using; refer to Section 6.1.1.3, page 44.

5.5.2 Connection of a GPS receiver

NMEA-compatible or Garmin GPS receivers can be connected to 
the Q.station 101 Test Controller via the USB interface. If your 
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device only has one RS-232 interface, you can use a commercially 
available RS-232-to-USB adapter.

Fig. 5-4 Settings for a GPS receiver from Garmin

Here, define the interface settings (for the connection refer also 
to Fig. 4-1 on page 17). If no new time information is received 
within the time period specified for the communication monitor-
ing, the Q.station 101 uses the next available synchronization 
method.

Evaluation of position data Use the variable GetPositioningData to evaluate the individual 
data items of your GPS receiver; refer to Fig. 5-5. You need one 
dedicated variable for each item of data supplied by your 
receiver. The various messages which contain the relevant value, 
e.g. GGA, are listed in the explanation of the command. You have 
to re-enter the port here, because several receivers may be con-
nected.
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Fig. 5-5 Output of the latitude (Parameter = 1) in a variable of the 
type ARITHMETIC_EMPTY; the GPS receiver is connected 
to USB1 (Parameter = 100; refer also to Fig. 5-4).

5.6 Installing the test.commander

➡ We recommend that you close all open programs before the 
installation. Administrator rights are needed for the installation.

Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window 
appears. If you have deactivated the Windows autostart function, 
find the file StartUp.exe in the main directory on the CD and give 
the corresponding symbol a double click to obtain the start win-
dow. Alternatively, you can also start the program Setup.exe in 
the folder test.commander to carry out the installation directly.

➡ The program ICP 100 is installed together with the program 
test.commander.

You will also find the relevant latest versions of the programs on 
our home page www.gantner-instruments.com via Software > 
Download.
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Procedure • Click on the symbol over Load software.

• Click on the symbol  next to the program which you 

want to install.

The program Setup.exe is started.

• Allow the file to open so that the installation can start.

The starting dialog of the setup program appears. 

• Follow the instructions of the setup program to define the 
installation directory and the program group for the software.

Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program test.commander is started for the first time, 
you specify the language for the program user interface (you can 
change your selection at any time via Extras > Settings > Lan-
guage).

For the program a license number is needed which you have to 
enter to be able to save configurations. You will find the license 
numbers in the PDF file enclosed with the supplied items and on 
the separate printout with your license data.

Then enter your license data via Help > Info and Licensing. If 
you have licensed the program test.commander, then the pro-
gram ICP 100 is also enabled and a further license is not 
required.

5.7 Ethernet on the PC

The following sections describe various settings which you can 
carry out on the PC to enable a link to be formed. The images use 
menus and dialogs found in Windows XP; the names of the dia-
logs and fields in other versions of Windows are however similar 
and are usually also given.

5.7.1 Finding the IP address and subnet mask of the PC

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (Fig. 5-6). In the following 
status dialog (similarly in Fig. 5-6) click on Details.

The current address is displayed in the next dialog under IPv4 
address.

The subnet mask determines which addresses can be reached 
from the PC: Only addresses whose figures are identical in the 
places which contain a 255 in the subnet mask can be reached. 
The IP addresses of the PC and Test Controller should normally 
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be located in the same Ethernet segment (only the last group of 
figures in the IP address is different), otherwise the subnet mask 
must be 255.255.0.0 so that the last two groups of figures may be 
different.

Fig. 5-6 Viewing/changing the IP address of the PC

Example 1 Subnet mask 255.255.255.0, IP address 192.168.100.26

Only addresses can be reached which start with 192.168.100, i.e. 
the first three groups of figures must be identical and only the 
fourth may be different.

Example 2 Subnet mask 255.255.0.0, IP address 192.168.100.26
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All addresses can be reached which start with 192.168, i.e. the 
third group of figures may also be different between the PC and 
Test Controller.

5.7.2 Setting the IP address on the PC

If you want to connect to a Test Controller, you must assign a 
(temporary) IP address to the PC.

➡ We recommend that a temporary IP address is set up on the PC, 
because then the network settings on your PC for the normal con-
nections are not changed. If you have already set up this type of 
“alternative configuration” for another network, you must note 
the existing settings so that you can restore them after conclud-
ing the configuration of modules or the Test Controller.

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (refer to Fig. 5-6 on 
page 36). In the following status dialog click on Properties 
(requires administrator rights). Then mark Internet Protocol 
Version 4 and click on Properties (refer also to Fig. 5-7).

Then proceed to the register card Alternative Configuration 
and specify an address for the PC, e.g. 192.168.100.5, and a 
subnet mask, e.g. 255.255.255.0 (Fig. 5-8).

Fig. 5-7 LAN connection properties (Windows 7 and 8).
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Fig. 5-8 Specifying the IP address and subnet mask for an alterna-
tive (temporary) configuration.

5.7.3 Allowing access to network devices (firewall)

Generally, a firewall monitoring access of the PC to the network 
and vice versa is installed on the PC. Therefore, you must allow 
access to the Test Controller or the module, otherwise no connec-
tion can be established via Ethernet. On the first attempt to 
establish a connection you receive a message similar to that 
shown in Fig. 5-9. Click on Allow access to allow the connection.

IMPORTANT
You must possess administrator rights on the PC to be able to 
unblock the connection. If this is not the case, ask your adminis-
trator to do this for you. You must enable all programs for sharing 
which use an Ethernet connection to the modules or the Test 
Controllers.
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Fig. 5-9 Firewall message from Windows 7 when attempting to 
connect through Ethernet; here for the Setup Assistant.
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6 Basic configuration of your 
system

You must first create a project and establish contact with the 
module before you can configure it. You will find a description of 
the working steps in Chapter 5, Q.station 101 connection, 
page 25.

The following chapter describes the most important settings to 
be able to measure with the Q.station.

IMPORTANT
If you would like to combine modules or Test Controllers from 
older applications and recently purchased ones, all components 
should use the latest relevant internal software, the so-called 
firmware. To ensure this, carry out a firmware update; refer to 
Section 6.6, page 72.

Basic procedure

• Establish the connection (communication) between the PC 
and Test Controller; refer to Chapter 5, Q.station 101 connec-
tion, page 25.

• Start the configuration program.

• First, start with the basic configuration of the Test Controller 
and leave the definition of further settings, such as system 
variables or storage settings, to the end.

• Enter the sensors used and their sensitivities to obtain an 
indication in the measured physical quantity. Define computa-
tions, digital inputs/outputs, alarm monitoring, etc. These 
working steps are described in the manual for the Q.series 
modules.

• Specify which data are to be recorded and how; refer to 
Chapter 7, Recording with the data logger, page 75.

• Activate all settings in the modules and in the Test Controller.

IMPORTANT
After changes to the configuration of modules or a Test Con-

troller  is displayed in the project tree. Select  or File > 
Write project (update) in the test.commander to update the 
settings in the project (and in the Test Controller). The project 
file is automatically saved. 
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Tip
At many points in the software you can call the setting dialogs or 
settings via the context menu of an entry. You call the context 
menu with the right mouse key.
You process a complete variable in the configuration dialog in 
that you click on the variable in the left column (contains the vari-
able number Vx) to mark it. Using the context menu, you can then 
cut, paste and copy the variable, overwrite it with a copied vari-
able or delete it.

6.1 Q.station basic settings

In the Test Controller you specify, for example, the type and 
scope of the synchronization, set the (synchronous) output rate 
and baud rate of the modules to be used or define which bus diag-
nostic data or life signs are to be transmitted. In addition, you can 
check all the settings of host and module interfaces, allocate a 
location name, etc. The following sections deal with the most 
important settings; further settings are explained in separate 
chapters.

Mark the Test Controller to be set and select Settings from the 
context menu or double click on the Test Controller to start the 
configuration program. 

Fig. 6-1 Configuration dialog for a Q.station Test Controller 
(extract).

Then you can carry out all the module settings in the window of 
this dialog. A tree structure similar to that in Windows Explorer 
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shows the individual parameter groups. Open up the entries as 

required by a click on .

6.1.1 Settings

Using this parameter group you define, for example, life signs or 
the location name. 

6.1.1.1 General remarks

Location Here you allocate a name for the Test Controller, e.g. the loca-
tion. The default setting is Undef.

PAC functionality The PAC functionality offers the possibility of autonomously 
implementing (independent of the PC) any functions of many 
measurement quantities and I/Os, calculations, logical opera-
tions, time and transfer elements, etc. with the graphical soft-
ware test.con.

Here, you activate or deactivate the general data access to 
Q.station variables (read and write) of the test.con applications 
from real-time and user space. The default setting is activated.

Buffer pre-initialization In the Fast filling default setting each measurement transferred 
with a bit error leads to an error: the measurement is set to -1 
(default setting for Filling pattern) and the error counter is set. 
This generally causes the test-rig to stop. In the setting Deacti-
vated the previous measurement is also used for the present 
measurement. If the next measurement is alright again, measure-
ment continues as normal. The error is however counted, but no 
alarm is triggered. In the Slow filling setting the process is the 
same for two seconds as in the Deactivated setting, thereafter as 
in the Fast filling setting. In this way brief disturbances are 
ignored.

Filling pattern Value which is used for a defective measurement (refer to Buffer 
pre-initialization).

Switching threshold of the 

digital inputs

Here, you select whether the TTL level (5 V) or the PLC level (24 
V) is used for the digital inputs. With TTL the switching thresh-
olds are <1 V and >3.5 V and the PLC levels are <7 V and >8 V.
Refer also to Section 4.2, page 17.

System cycle frequency The system cycle frequency provides the (internal) clock for the 
processing of virtual variables and test.con applications in the 
Q.station. The cycle frequency can be set slower or equal to the 
highest sample rate. The maximum cycle frequency is 10 kHz; it 
determines the system load.
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6.1.1.2 Life sign

Here you specify how the life-sign signal (Live signal) is to be pro-
duced. You can output a static signal which only changes its sta-
tus when an error occurs or you can use a dynamic signal which 
changes its status between high and low with a certain fre-
quency. You enter the frequency or the half-cycle time under I/O 
status change time in seconds. Choose the conditions for which 
an error is to be signaled.
Refer also to Section 4.2, page 17.

IMPORTANT
The conditions change (note text) when you switch over from 
Static to Dynamic, because logical operations with AND or OR 
are carried out depending on the type of signal.

6.1.1.3 Synchronization

In the menu Input synchronization protocol you set both the 
type of synchronization used and also the inputs used for it.

If your device is operated as a slave, i.e. if you connect another 
Test Controller which has the time information available to SyA 
and SyB or you connect a radio receiver for time signals with an 
RS-485 output to these connections, specify Q.sync via RS-485.

IMPORTANT
The maximum length of the synchronization cables on SyA and 
SyB is 400 m.

Specifying EtherCAT DC Time (distributed clock) is only practi-
cable when an EtherCAT master is present.

In the setting None the Test Controller operates with the internal 
time (as master for other connected Test Controllers).

If you want to synchronize via SNTP, you have to specify the time 
server using Host interface > SNTP; refer to Section 6.1.3.5, 
page 51.

6.1.2 Module interface

Using this parameter group you specify the speed of the data 
transmission on the individual interfaces (UARTs). Also, the baud 
rate for the CAN bus interface is set here.

6.1.2.1 UART interfaces (RS-485 #1 to #4)

Select the required baud rate (transmission speed). The default 
setting is 24 MBaud.
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Fig. 6-2 Baud rate selection.

The maximum possible speed depends on the overall length and 
quality of the cable which is connected to the relevant interface. 
When using high quality cable, the maximum achievable dis-
tances are:

Note that depending on the quality of the cable used (capacitance 
per unit length, loop impedance and characteristic impedance) 
the achievable distances may be substantially shorter. In all 
cases make sure that the terminating resistances are activated 
(Section 5.4.1, page 27).

➡ A change in the baud rate is also carried out automatically on the 
modules connected to the interface.

Communication monitoring With a value > 0 the module error LED is activated if there is a 
lack of communication after this period.

Response delay This parameter is only needed when the modules are not directly 
connected to this interface, but instead connected to a modem, 
for example. Then enter the time here which is to be awaited 
additionally due to the slow connection.

Cable length in meters Maximum baud rate

1000 < 500 kBd

100 < 1500 kBd

20 < 6000 kBd

10 >6 to 24 MBd
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6.1.2.2 CAN bus interface

You can both read and send data over this interface. The maxi-
mum possible speed depends on the overall length of the cable 
which is connected to the relevant interface.

IMPORTANT
A change in the baud rate only affects the Q.station; connected 
CAN devices must be set to the selected baud rate separately.

Communication monitoring With a value > 0 the module error LED is activated if there is a 
lack of communication after this period.

Response delay With this parameter you can specify an addition time-out period 
which is allowed to pass before communication monitoring sig-
nals an error.

6.1.2.3 Setting up a further CAN bus interface via USB

If required, you can use a further CAN bus interface by employ-
ing the PCAN-USB adapter from PEAK-System Technik GmbH 
(http://www.peak-system.com).

During the configuration of the Test Controller in the section 
USB devices specify CAN as the protocol and set the CAN baud 
rate to be used (Fig. 6-3). Refer to Section 6.4.2, page 61 for the 
definition of the data to be read in or to be output.

Cable length in meters Maximum baud rate

1000 < 50 kBaud

100 < 500 kBaud

50 < 800 kBaud

25 <1 MBaud
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Fig. 6-3 Configuring the CAN interface via USB.

6.1.3 Host interface

This parameter group defines the settings for the communication 
over the interfaces EtherCAT, Modbus, Ethernet, FTP and Data-
port and it enables you to implement access protection for the 
Q.station.

Here you also have the possibility of specifying e-mail settings for 
messages from a data logger and of defining network drives 
which the Q.station Test Controller can access for data storage. 
This means that a data logger can also save to a network drive 
and not just to a local drive.

6.1.3.1 Field bus (EtherCAT)

The section contains the settings for the EtherCAT interface. 
Deactivate the interface if you do not need it.

IMPORTANT
Using the context menu of the Test Controller and Assign read/
write accesses, define which variables are to be available on the 
field bus. Activate the read access (READ rights) in the Field 
bus column for the relevant variable (Fig. 6-4).
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Fig. 6-4 Enable read access for the field bus.

Communication monitoring With a value > 0 and with a lack of communication after this 
period the error status becomes active; refer to Section 4.4.1.3, 
page 21.

Frequency divider This value determines the transfer rate for the EtherCAT inter-
face. The divider is required at high data rates to avoid overload-
ing the interface. The value refers to the sample rate #1 and 
reduces, where applicable, the data rate on the EtherCAT inter-
face. With a setting of 4 and a sample rate #1 of 4000 Hz the 
transfer rate is 1000 Hz (Fig. 6-5).

Fig. 6-5 Setting for the frequency divider.

6.1.3.2 Ethernet

Use this section to assign a fixed IP address to the Q.station or to 
set it to DHCP again if you are using the version Q.station 101 or 
Q.station 101 T (without display).

➡ The stated static IP address is only effective when no DHCP 
server is being used.
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The IP address used in the setting Use DHCP server: Yes can be 
found under General remarks; refer to Section 6.1.3.8, page 52.

6.1.3.3 FTP

Server settings With the function Server settings > Access names you can 
implement access control (password protection).

IMPORTANT
You can work completely without any (Access name: No) or with 
all three passwords.

Note down the passwords and keep them in a safe place. If you 
have forgotten a password, note down the serial number of your 
Test Controller and contact us: office@gantner-instruments.com

You then receive a release code which resets all three passwords.

Client settings Here you define an FTP server with which the Q.station can con-
nect as client. You can then specify for a logger that the created 
files are sent directly to the FTP server.

IMPORTANT
You have to set up an FTP server appropriately on a PC. There 
are many programs which facilitate this, e.g. FileZilla.

Fig. 6-6 Details about the FTP server so that the Q.station can 
access it as a client.
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Check whether the settings for your FTP server at Connecting 
timeout, Communication monitoring or Transmission inter-
val have to be changed. Then specify how many (maximum ten) 
FTP servers you would like to set up. The FTP servers can also 
only differ due to the directories. The directory specified at 
Directory is created as a subdirectory to the directory released 
in the FTP server.

Use passive mode With a passive FTP the client sends a special command which 
causes the server to open a port and to send the port and IP 
address to the client. The client uses a port via 1023 and the port 
just transmitted by the server. This technique is necessary when 
the server itself is not capable of establishing a connection to the 
client, when the client is located behind a router or when a fire-
wall screens the client from external access.

Type Since the FTP server can be set up on any operating system, the 
client needs information about the form of the response to an 
interrogation of the directory. Unfortunately, this is not standard-
ized and, depending on the operating system, the file information 
is transmitted in various formats. Using this, the client can 
request the size of a file. Therefore, with the Unknown format 
only a check is made of whether a file with the name of the trans-
mitted file exists. A check cannot be made of whether the file has 
the right size, i.e. whether all the data has been transmitted.

Directory With this option you can define a subdirectory on the FTP server. 
If you would like to save the data from different loggers in differ-
ent directories, simply create the same FTP server with different 
subdirectories, e.g. /Data1 and /Data2.

Tip
Within the specified directory you can have the logger create fur-
ther subdirectories by using placeholders. The placeholders pos-
sible are identical with those described in Section 7.3.1 for Log-
ger name; refer to page 81.

IMPORTANT
A differentiation is made between upper and lower case in the 
directory path notation.

6.1.3.4 Network drives

You can also use a network drive as the target memory for a log-
ger, if you do not want to record on a storage medium on the 
Q.station (e.g. on USB). You provide the required details via this 
dialog (Fig. 6-7).
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Name Here, enter the name which is to be used later in the logger for 
this target memory.

User name Here, enter the user name for which the target memory, i.e. the 
directory, is released.

Password Password for the user name.

Host name IP address or name (requires a DNS server) of the PC on which 
the directory is located.

Fig. 6-7 Specifying network drives.

Remote folder Here, enter the directory path, e.g. /Data/EngineTest. The path 
name corresponds to the directory path from the released folder.

Example: You have released the subfolder DataFiles in the folder 
Testing on drive D:. The directory path is then /DataFiles, 
because (at least in the default setting) this is the name of the 
release on the relevant PC (host name). On release you can how-
ever also set a different name as the release name.

6.1.3.5 SNTP

Here, specify the IP address of the NTP server if you want to set 
up synchronization via NTP.
Refer also to Section 5.5, Synchronization of several systems, 
page 29.

6.1.3.6 E-mail

For a logger to be able to send e-mails you must here define the 
possible selections for the fields Address, Subject and Content.

In the dialog (Fig. 6-8) specify:
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• To which server the mails are to be sent (Sender server 
address),

• whether and if yes, how the authentication is to occur,

• how many e-mail addresses and how much information (sub-
ject, content) you need.

You can specify up to ten different addresses, subject lines and 
content texts. You can state, for example, the location or test rig 
of the Test Controller in a Signature; the text is then always 
appended to the end of the mail.

For the configuration of the e-mail refer to Section 7.3.3.8, Send-
ing an e-mail, page 88.

Fig. 6-8 E-mail settings.

6.1.3.7 Dataport

This section contains the settings for Modbus if this is being used 
via TCP/IP (Modbus/TCP).

6.1.3.8 General remarks (own IP address)

In the DHCP setting this shows the current IP address.

6.1.4 USB devices (GPS, Modbus, CAN)

In this section you can define special USB devices, e.g. a Garmin 
GPS receiver or generally an NMEA-0183-compatible GPS 
receiver (refer to Section 5.5, Synchronization of several sys-
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tems, page 29), a Modbus interface or a PCAN-USB adapter 
(refer to Section 6.1.2.3, Setting up a further CAN bus interface 
via USB, page 46).

Modbus interface

You can also set up a Modbus connection via the USB-to-RS-485 
converter ISK 103 from Gantner. The drivers for the converter 
are present in the Q.station from firmware version 1.09, but you 
can also connect many commercially available converters. Click 

on  or use File > Read online status information from 
controller to call up the status information of the Test Controller 
which shows whether the converter has been detected (Fig. 6-9).

Fig. 6-9 Status information with detected USB converter on USB1 
(indicated as usb_0).

Then define Modbus as the Protocol and specify the data for 
your bus system: Should the Q.station operate as Master or 
Slave, which baud rate is to be used, etc. (Fig. 6-10). In the con-
figuration as master you can, for example, receive data from an 
Ammonit Meteo-40 data logger or transfer Modbus data by radio 
via two Phoenix RAD-2400-IFS radio modules.
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Fig. 6-10 Defining Modbus as the interface for the USB converter.

Transfer format Specify which parity is to be used: none (n), even (e) or odd (o). 
Eight data bits and one stop bit are always used so there are only 
the settings 8n1, 8e1 (standard) and 8o1.

Communication monitoring With a value > 0 and with a lack of communication after this 
period the error status becomes active; refer to Section 4.4.1.3, 
page 21.

Response delay With this parameter you can specify an additional time-out period 
which is allowed to pass before communication monitoring sig-
nals an error.

The other settings can be carried out via the details for the virtual 
variables which are to receive data from this interface or send 
data to it; refer to Section 6.4.5, Defining Modbus RTU signals, 
page 67.

6.1.5 Sample rate and logger settings

With the Q.station you can set up to four sample rates and data 
stores. On the data logger you define which data are saved, how 
often and where. The settings are written in a chapter of their 
own; refer to Chapter 7, Recording with the data logger, 
page 75.

6.2 System variable

Below the basic settings for the Q.station there are also two 
entries for defining variables. 
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IMPORTANT
The variable Timestamp created in the default setting (DC sys-
tem time, i.e. date and time since 1.1.2000) must not be deleted. 
You can however rename the variable. The time format has a res-
olution in μs.

In the System Variables section specify further time variables if 
you would like to use time formats other than in the default sys-
tem time. Context menu for system variables Add new variable 
> ABSDATETIME. After a double click on the variable and a fur-
ther click on Formula you can then select other formats (Fig. 6-
11).

Fig. 6-11 Dialog for specifying the time format.

In the System variables section (or in the Virtual variables sec-
tion) you can also define time variables, e.g. if actions are to be 
carried out at a certain time of day or hourly: Context menu Add 
new variable > ARITHMETIC _EMPTY. Then click on For-
mula to select a function.

6.3 Specifying digital inputs/outputs

In this section you create the variables for your digital inputs and 
outputs. You can also combine several inputs or outputs to form a 
status field and use two inputs for an up/down counter or a 
rotated-angle signal with direction detection. PWM or frequency 
measurements are also possible.
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6.3.1 Digital inputs

In the context menu for Digital I/O select New variable > DIGI-
TAL_INPUT. You can also import existing variable definitions 
(New variable > Open folder in Explorer).

Fig. 6-12 Configuration dialog for a digital input.

6.3.1.1 Type of input

The setting determines how the input is used and which further 
settings you must carry out.

1. Status

With this function it is only necessary to specify the connec-
tion terminal. You can leave all other settings on the default 
setting, because here only the high or low level is evaluated.

2. Frequency

You can choose between a simple frequency measurement 
(Frequency, standard) and Frequency, 2-wire. The latter 
enables you to detect the direction of rotation through the 
sign of the frequency (rotational speed) using two digital 
inputs.

The setting cannot be currently configured interactively. If 
required, please contact our Support.

3. Counter

Here, you can choose between a simple counter (Counter, 
standard), a forwards/reverse counter with two signals offset 
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by 90° (Counter, quadrature 2-wire), a forwards/reverse 
counter with a static direction signal for forwards/reverse 
(Counter, up/down) and a forwards/reverse counter with 
two 90° offset signals plus index signal (Counter, quadra-
ture 4-wire), i.e. a reference signal at a zero position.

The setting cannot be currently configured interactively. If 
required, please contact our Support.

4. Pulse duration

Pulse duration, period measures the time between the low-
to-high edges of a signal. Pulse duration, active measures 
the time at the high level, Pulse duration, passive measures 
the time at the low level. With Pulse duration, PWM duty 
cycle the ratio between the time period at high level to the 
time period at low level is evaluated.

If required, you can specify a conversion factor between the 
pulse duration or the duty cycle of the input signal and the 
displayed value using Scaling type. Set the Data format, 
e.g. to SINT32 (signed integer, 32 bit), Field length 8 and 
Decimal (places) 4 (the decimal point also counts as a place).

5. Status field

With the Status field function you can combine several inputs 
to form a field. The inputs are evaluated as binary.

The setting cannot be currently configured interactively. If 
required, please contact our Support.

The following block diagrams give you an overview of the possi-
ble circuits.

Measurement of status, time, frequency or PWM 
(Pulse-Width Modulation), 1 signal

Up/down counter or measurement of frequency and direction with 

static direction signal, 2 signals

Din
0V

Din

+/-

0V
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Measurement of frequency and direction or up/down counter with 

2-channel frequency signal (90° phase delay)

Measurement of frequency and direction or up/down counter with 

4-channel frequency signal

6.3.2 Digital outputs

With the digital outputs you have the choice between Status (sin-
gle input, high or low) and Status field (several gated inputs). 
The input of a unit or of scaling information is only practicable 
with Status field.

➡ Note that DO1 is assigned with the live signal; refer to Digital 
outputs and power supply, page 19.

In the Status field setting DO2 is used for 22, DO3 for 21 and 

DO4 for 20. However, you do not necessarily have to assign all 
these outputs as only those outputs assigned with Status field 
are controlled. The setting cannot be currently configured inter-
actively. If required, please contact our Support.

IMPORTANT
Using the context menu of the Test Controller and Assign read/
write accesses, define which outputs are to be made available, 
e.g. for the field bus or the Test Controller (Pac kernel column). 
Activate the write access (WRITE rights) for the relevant output 
(Fig. 6-13).

Din

0V

Din

Index

Index 
enable

0V
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Fig. 6-13 Enabling write access.

6.4 Virtual variable

With virtual variables you can implement calculations, evaluate 
trigger conditions, carry out assessments or define CAN bus or 
Modbus signals for input or output. The variables can be output 
like measurements or you can link them to other variables, mea-
surements or digital I/Os. Virtual variables are also needed if you 
want to output computational results from a logger, e.g. by 
EtherCAT or Modbus/TCP. The maximum processing speed is 10 
kHz.

IMPORTANT

After creating new variables select  or File > Write project 
(update) in the test.commander to transfer the new definition to 
the Test Controller. The project file is in this case automatically 
updated.

6.4.1 Defining formulas and events

In the context menu for virtual variables select Add new vari-
able > ARITHMETIC_EMPTY. After a double click on the vari-
able you can either specify a formula for the computation, define 
an event which is to be monitored (trigger) or specify the data 
format to be used (Fig. 6-14).
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Fig. 6-14 Configuration dialog for a virtual variable.

Click on, for example, Formula to enter a computation (Fig. 6-
15).

In the dialog you have available all variables already defined (tab 
V1-10 and other tabs if more than ten variables have been 
defined). Click on one of the variables to insert it into the for-
mula. Use the field Functions and operators to select a mathe-
matical or logical function (select the function and click on 
Select function so that it is accepted into the formula field). 
Where required add brackets (simply enter them via the key-
board) in order to obtain the correct computational sequence. 
The syntax of the selected function is explained in the lower sec-
tion of the window. If required, zoom on this section to be able to 
read the text easier.

Close the dialog with OK.
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Fig. 6-15 Defining a computation (formula).

6.4.2 Defining CAN signals

You have a number of ways of defining CAN signals:

1. Create input signals using the virtual variable CAN_INPUT.

2. Create several input signals through the import of a Vector 
CANdb database.

3. Define output signals through the  symbol.

4. Define output signals through the virtual variable CAN_OUT-
PUT (no longer recommended).

6.4.2.1 Defining single CAN signals

In the context menu for virtual variables select Add new vari-
able > CAN_INPUT. After a double click on the variable, you 
can change the name and enter the CAN parameters (Fig. 6-16). 
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Fig. 6-16 Example of a CAN signal.

6.4.2.2 Importing CAN signals from CANdb

By importing signals from a CAN database in Vector CANdb for-
mat (file extension dbc) you can create several variables in one 
step. In the context menu for virtual variables select Add new 
variable > Import CAN variables from DBC. Select the file 
and in the following dialog (Fig. 6-17) mark the signals which you 
want to import. Marking messages reads all signals, but you can 
also mark individual signals.

Fig. 6-17 Selecting CAN signals or messages.
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6.4.2.3 Defining CAN outputs

Mark the Test Controller and click on the  symbol to call 
the dialog. In the dialog (Fig. 6-18) specify which signal is to be 
output on which CAN bus and how it is to be output.

Fig. 6-18 Defining output signals for the CAN bus.

The example in Fig. 6-18 illustrates several variants for transfer-
ring data:

1. The variable V6 (Load_Cell) is output continuously (Writing 
rule: Cyclical) on CAN 1 with the CAN ID 305; the Cycle 
time is 1000 ms.

2. The variables V7 and V9 (Force left/right) are output in one 
message with the CAN ID 306 when one of the values 
changes. Here, the variable V7 occupies the least significant 
32 bits (Start bit: 0), the variable V9 the most significant bits 
(Start bit: 32).

3. The variables V8 and V10 (TensileForce left/right) are output 
via the CAN bus connected to USB 1 (refer to Section 6.1.2.3, 
Setting up a further CAN bus interface via USB, page 46) 
when one of the values changes. The CAN ID is in both cases 
307, i.e. the signal is multiplexed. The information of which 
signal is transferred is embedded in the MUX value (1 or 2). 
The value is transferred in the Intel format with the MUX 
start bit 0 and the MUX length 8 bits. You can mask out cer-
tain MUX values via the MUX mask (not used here).

Tip
For the output signals defined here a Vector CANdb file is auto-
matically produced in the project folder if you activate the option 
Create CAN DBC file using the menu Extras > Settings and 
Project settings.
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6.4.3 Variable for computational results from a logger

In order to be able to output computations from a logger (refer to 
section Create statistics or arithmetic channels, page 83) or to 
use them in other computations, you have to “pack” them into a 
virtual variable.

In the context menu for virtual variables select Add new vari-
able > LOGGER_INTERNAL.

Fig. 6-19 Configuration dialog for an internal logger variable

Select the logger which computes the variable and state the vari-
able. All available (defined) variables are shown in the list (Fig. 6-
19). Specify the data format, how the value is to be transferred 
and note which output is provided for this (with EtherCAT or 
Modbus/TCP you have to use at least two bytes).

6.4.4 Variable for the status of a logger

You also create a variable for a logger status in a similar way as 
for a variable for computations from a logger.

In the context menu for virtual variables select Add new vari-
able > LOGGER_INTERNAL. Then specify Logger status as 
the Variable type.
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Fig. 6-20 Configuration dialog for a logger status variable.

You then have numerous possibilities available in the Status 
field. For example, you can use the variable to check whether the 
logger is active (enabled), whether the start or stop trigger has 
occurred, how many files have been saved or also how much 
space is still present on the target drive (refer to Explanatory 
table of terms).

Status Explanation Parameter

Enabled
Indicates whether a data logger is acti-
vated

1 = Data logger saved
0 = Data logger not saved

Logging
Indicates whether the data logger is cur-
rently saved

1 = Storage process is active
0 = Storage does not take place

Start trigger Indicates whether a start trigger is active
1 = Start trigger is active
0 = Start trigger is not active

Stop trigger
Indicates whether a stop trigger is cur-
rently active

1 = Stop trigger is active
0 = Stop trigger is not active

Saved files

States how many files the data logger has 
saved since the function was activated. 
This is not the number of files which the 
data logger has created since switch-on or 
shipment.

–

File progress

Filling level of the current file (0 - 100%). 
100% signifies that the file is complete 

(setting of Size of a single file).
–
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Trigger progress
Storage length of the current logger 

file in percent (0 - 100%)
–

Mails sent
Number of mails sent since the function 
was activated

–

FTP sent
Number of files sent by FTP since the 
function was activated

–

Target

Index of the target memory (from the list 
of target memories) on which storage is 
currently taking place. The index of indi-
vidual target memories is shown with the 
status information of the test controller. 

In the mode Automatic drive selection 

you can find out to which memory writing 
is currently taking place.

Example:
SD0 = Index 0
USB0 = Index 1
USB1 = Index 2

Target size

Total capacity of the memory in bytes. 
This is a fixed size which only changes 
when you connect another memory. Refer 
also to the following parameters.

–

Target remain-
ing

This indicates how many bytes are still 
free on the memory medium to which 
writing is taking place.

–

Target occupied
This indicates how much space is already 
taken up on the current target memory (0 
- 100%).

–

Data source 
overflow

Here, the value 0 should always be read. 

Otherwise (≥1) the data are lost. The 

value states the number of overflows of 
the ring buffer. 

–

Data source cur-
rent size

This indicates how many bytes were in the 
ring buffer the last time the data logger 
wrote to it. The indication should always 
stay the same. If it becomes larger, then 
an overflow of the buffer memory is immi-
nent.

–

Data source 
capacity

Maximum capacity of the ring buffer in 
bytes. This is a fixed size.

–

Status Explanation Parameter
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1) Post-processor: When a data logger is not operating at the same speed as its data source, 
i.e. the ring buffer, or if data is being computed in the logger, the Q.station produces a 
post-processor. The logger fetches its data from it. The post-processor and the ring buffer 
are therefore are memories where one directly follows the other.

6.4.5 Defining Modbus RTU signals

In the context menu for virtual variables select Add new vari-
able > MODBUS_RTU.

Modbus interface In Fig. 6-21 the USB-to-RS-485 converter ISK 103 is used to 
access the Modbus interface: USB 1 (refer to Section 6.1.4, 
page 52).

Sensor address Address of the receiving or transmitting bus device.

Data source 
maximum size

This shows the size of the largest packet 
that has been fetched from the ring buffer 
by the data logger. The value remains 
valid as long as no buffer overflow occurs. 
The value is reset when the data logger is 
deactivated.

–

Post-processor1) 
overflow

Here, the value 0 should always be read. 

Otherwise (≥1) the data are lost. The 

value states the number of overflows of 
the post-processor.

–

Post-processor1) 
current size

This indicates how many bytes were in the 
post-processor the last time the data log-
ger wrote to it. The indication should 
always stay the same.

–

Post-processor1) 
capacity

Maximum capacity of the post-processor 
in bytes. This is a fixed size.

–

Post-processor1) 
maximum size

This shows the size of the largest packet 
that has been fetched from the post-pro-
cessor by the data logger. The value 
remains valid as long as no buffer over-
flow occurs. The value is reset when the 
data logger is deactivated.

–

Status Explanation Parameter
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Fig. 6-21 Variables for Modbus signal.

Modbus register type Depending on whether a value is to be read or written, you have 
to specify the appropriate Modbus register type in the dialog. For 
inputs usually the hold registers from 30,000 onwards are used 
and for outputs the registers from 40,000.

Registers Here, you specify the register address to be used (from the range 
defined above).

Modbus rules/
writing rules

Specify how values are to be read and written: Cyclical, only 
with a change of the value or on request (via host). With Fast the 
values are processed at the system cycle frequency (refer to 
page 43).

If you select Cyclical, you then have to state the Cycle time.

Modbus data format Specify in which format the value is to be transferred on the Mod-
bus. The FLOAT format requires four bytes and therefore two 
registers.

Scaling Here, if required, you can scale the value transferred on the Mod-
bus.

Behavior on sensor error Here, you define the value to be displayed when the Modbus 
device no longer supplies any values.

Data format
(in the Q.station)

Here, you define in which format the value is provided in the 
Q.station and whether it involves an input or output (data direc-
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tion). For example, you can convert a FLOAT value on the Mod-
bus into DOUBLE, i.e. a 64-bit value (double precision). Note that 
the formats must have at least two bytes in order to be able to 
fully transfer the Modbus information.

Reading/writing rights Here or using the context menu of the Test Controller and 
Assign read/write accesses, define whether the variables are to 
be available for other interfaces. Then activate the access (Read 
or Write) for the relevant interface.

6.5 Online tools

6.5.1 Read data buffer (with measurements) 

Click on  or use File > Read online data buffer from con-
troller to be able to read out and view all values from the ring 
buffer. 

Fig. 6-22 Display of the buffer content with test.viewer.

You can carry out further settings using the menu and symbols, 
e.g. display the channel list, show the spectra or transfer a live 
stream of data.
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6.5.2 Displaying measurements

Click on  or use File > Read online values from control-
ler to be able to view the values of your variables. If you have 
defined appropriate variables, you can also set initial values in 
this dialog.

Fig. 6-23 Dialog for displaying the variable values.

In the dialog click on Show online graphics to display the val-
ues in a graph over time.

6.5.3 Reading module information

Click on  or use File > Read online module info from 
controller to be able to display information such as the address 
or serial number of your system.

Fig. 6-24 Display of the module information.
Vers. No. 1.5
70 Released: 15/10/2018



6     Basic configuration of your system → Online tools
6.5.4 Reading status information

Click on  or use File > Read online status info from con-
troller to display status information of your system.

Fig. 6-25 Display of the status information.

Explanation of logger information

Act States whether the logger is activated (1) or not (0).

Des Target memory, e.g. sd0 (SD card).

Log States whether the logger is currently recording (1) or not 
(0).

TOn States whether the start trigger is active (1) or not (0).

TOff States whether the stop trigger is active (1) or not (0).

TVal Shows the current value of the trigger variable.

File States the size of the current file in percent (0 - 100%).

Trig States the progress of the current trigger process in per-
cent (0 - 100%).

Stor States how many files have been saved since starting the 
logger.

Mails States how many mails have been sent since starting the 
logger.

FTP States how many files have been sent since starting the 
logger.
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6.6 Firmware update

Recently purchased modules or Test Controllers always contain 
the latest firmware, i.e. the software in the modules or Test Con-
trollers is the current version. However, if you want to combine 
these modules with older modules and/or Test Controllers, you 
must update all older modules or Test Controllers and it is essen-
tial to update your software to the latest version, because other-
wise disturbances in operation due to a communication failure 
may occur.

IMPORTANT
Up to and including the serial number 750638 the firmware 
update requires a restart of the Q.station Test Controller (switch 
supply voltage off and then on again). If you have no direct access 
to the device, you should use, for example, an outlet strip which 
can be switched via Ethernet.
This is no longer necessary from the serial number 750639 (from 
the first quarter of 2015).

The current firmware is in each case included in the latest instal-
lations of the programs ICP 100 or test.commander. Here, the 
program licenses apply to all versions of a program. If required, 
download the latest versions from our web site: www.gantner-
instruments.com. You will find the programs under Software > 
Download.

6.6.1 Firmware update for Q.station

Before a new installation is carried out, uninstall the existing ver-
sion using the Windows Control Panel. Install the latest version of 
the test.commander so that you can also install the latest version 
of the firmware on your PC.

Procedure 1. In the program test.commander select Utilities > Controller 
firmware update.

The network in the segment of the PC address is searched and 
the Q.station Test Controllers which are found are displayed 
in the window. If no Test Controller is found, you may have to 
enter the address manually or set the IP address of your PC to 
the segment used by the Test Controller; refer also to 
Chapter 5, Q.station 101 connection, page 25.

2. Mark the Test Controller to be updated and click on OK.

The update tool is started and the Test Controllers present in 
the network are displayed again.

3. Mark the Test Controller to be updated and click on Update.
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The Windows file dialog is opened and shows you the latest 
firmware version available on your PC. (After the installation 
of the latest version the latest firmware is also installed. The 
version is found from the ID number of the Q.station (module 
ID number)).

4. Mark the newest of the available firmware versions (if neces-
sary, switch to the detailed view) and click on Open.

The update process is started. Wait until the update has fin-
ished. 

Up to and including the serial number 750638 you have to 
restart the Q.station by interrupting the power supply for 
about five seconds to conclude the update. This is indicated 
with a dialog.

This is no longer necessary from the serial number 750639 as 
the power supply is interrupted internally in the Q.station for 
five seconds.

5. Click on OK and close the window of the update tool. 

Wait until the Q.station has finished the restart. The firmware 
update is now completed.

6.6.2 Firmware update for modules

Install as required the latest version of the test.commander so 
that you can also install the latest version of the firmware on your 
PC.

Procedure 1. In the program test.commander select Utilities > Module 
firmware update. 

2. Make sure that the settings with regard to the interface used 
are correct: Options > Communication settings.

3. Search for the Test Controller or the modules: Find modules.

4. If the modules are connected via a Test Controller, in the next 
window mark the Test Controller to which the modules to be 
updated are connected and click on OK.
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7 Recording with the data 
logger

The Q.station Test Controller enables you to save up to four sam-
ple rates in up to 20 data loggers. First, you specify how many 
sample rates you require (and associated data buffers). Then 
specify for the individual channels (UARTs) which sample rate it 
is to be used. In the third step you define the settings for the log-
ger(s).

IMPORTANT
The settings of the channels to be recorded are based on the 
channel names. When you retrospectively rename channels, the 
(old) channel names are no longer found and the relevant chan-
nels are deactivated.

The settings are made via the system view (allocation of the chan-
nels to the sample rates) and via the following context menus of 
the Test Controller:

• Settings for sample rates and data buffers,

• Logger settings for creating and setting the data loggers.

IMPORTANT
The configuration files are not completely downwards compati-
ble. Therefore, check all the settings (logging rate, recording 
modes, etc.) and the variables if you have carried out a firmware 
update of the Q.station Test Controller and then loaded an old 
project.

7.1 Setting the sample rates (and data buffers)

Call the dialog via the context menu Settings of the Test Con-
troller (Fig. 7-1).

For each sample rate you also have to define a data buffer (ring 
buffer) which accepts the (original) values. Whether and how 
these values are processed later in the logger or via, for example, 
EtherCAT is not relevant here. You can, for example, use two 
data loggers and then “fill” one with the original sample rate and 
the other with a reduced data rate (= logging rate) (refer to Log-
ging rate, page 84).
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Fig. 7-1 Setting the sample rates.

Number Enter the required number of sample rates if you want to use 
more than one sample rate (up to 4 are possible).

➡ You should only use one sample rate per UART, especially with 
analog signals. Two sample rates which are to operate through 
one UART (one bus system) may otherwise lead to (small) inaccu-
racies in the time pattern of the measurements. If required, you 
can write single modules to a logger at a reduced data rate. How-
ever, the data buffer should be filled with the same sample rate 
for all modules of a UART. If in doubt, use the higher sample rate 
for all modules of a UART.

Sample rate #1 to #4 Sample rate #1 (ring buffer 1) has a special role: It is the basic 
sample rate of the system. No other sample rate can be higher 
than sample rate #1. At the same time it provides the synchroni-
zation base for the other sample rates, i.e. the other sample rates 
are synchronized to this sample rate such that at time points 
where a measurement is taken at a lower sample rate, this occurs 
at a time point where a measurement also takes place at sample 
rate #1. This is not the case only in the Synchronization 
source: external operating mode.

IMPORTANT
If you change sample rate #1, the system cycle frequency is also 
changed such that the ratio between the sample rate and the sys-
tem cycle frequency remains the same. For example, if you have 
chosen a system cycle frequency of 1000 Hz and you then reduce 
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sample rate #1 from 10,000 Hz to 1000 Hz, then the system cycle 
frequency is also reduced to 1/10, i.e. to 100 Hz.

Name You can leave the default name as it is or use the purpose of the 
sample rate in the name, e.g. SlowSampleRate.

Synchronization source With the first sample rate you cannot specify a synchronization 
source, because this sample rate is the basic sample rate of the 
system.

In the default setting the other sample rates are internally syn-
chronized to sample rate #1. With sample rates 2 to 4 you can 
however synchronize to an external signal (Synchronization 
source: external), e.g. to obtain a measurement with angular 
synchronization (refer also to Section 7.4.3, Angular synchronous 
measurement, page 101). In this case you have further entry 
fields available:

• Digital input

Specify on which digital input the synchronization signal is 
applied. Note that DI1 may be used for time synchronization.

• Edge

Specify whether the rising or falling edge is to be used.

• Debounce

If the signal is produced by a mechanical contact, you can 
suppress the effect of a bouncing contact with this setting: 
The level is only valid when – at a sampling frequency of 48 
MHz – the number of samples (measurements) specified here 
exhibit the appropriate level (edge-dependent).

• Minimum time between two syncs

With this setting you can also suppress bouncing or brief dis-
turbances after an edge: The next edge is only monitored 
when the time specified here has expired. Make sure that the 
specified time is shorter than the time between consecutive 
pulses at the highest rotational speed.

• Reset mode for time stamp

Here you can reset the cycle counter in particular for angular 
synchronous measurement. The Q.station supports four dif-
ferent methods and further entry fields are provided depend-
ing on the method:

– Reset on reference pulse, i.e. when a (single) pulse occurs 
on the Reset input for time stamp (digital input), the 
counter is reset and the counting starts at one again with 
the next pulse.

– Reset on reference gap, i.e. pulses must also occur on the 
Reset input for time stamp simultaneously with the syn-
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chronization pulses. If the pulse on the reset input is miss-
ing, the counter is reset.

– Reset on falling edge of the reference signal, i.e. when the 
level on the Reset input for time stamp goes low, the 
counter is reset.

– Reset on rising edge of the reference signal, i.e. when the 
level on the Reset input for time stamp goes high, the 
counter is reset.

Whether, when and which method you can use, depends on 
the angle sensor used. Usually a pulse on reaching the zero or 
starting position is output, i.e. depending on the length of the 
pulse, you can use the first or one of the two last methods.

Sampling frequency No sample rate may be higher than sample rate #1. The sampling 
frequency is the frequency with which the measurements are 
read into the Test Controller and it is independent of the logging 
rate of the logger.

➡ The updating of virtual and system variables is not determined by 
the sample rate, but rather by the cycle frequency of the system; 
refer to System cycle frequency in Section 6.1.1.1, page 43.

Time stamp With sample rates 2 to 4 you can also specify a different time 
source as the System time DC (distributed clock). The system 
time is always used in sample rate 1. This must not be changed.

Specifying Cycle counter is practicable, for example, with exter-
nal synchronization, in particular together with a reset signal; 
refer also to Synchronization source, page 77. With this you can, 
for example, implement a channel containing a measure for the 
angle and which is set to zero after each full revolution.

Buffer size The data buffer operates as a ring buffer, i.e. the oldest values 
are overwritten once the data buffer has been filled. Each data 
buffer can be read simultaneously from several points: Up to 10 
connections are possible just over Ethernet alone.

Overall, for all (four) data buffers you have 200 Mbyte available. 
This space can be divided as required. You can, for example, allo-
cate half the space to one data buffer and divide the rest between 
the other three or use the whole space for one data buffer.

➡ The size must always be given in bytes, so therefore check the 
number of zeros. A figure given in seconds or similar is not possi-
ble.

7.2 Assign sample rates to the channels

In the Sample rate column of the system view select the 
required sample rate for the relevant channels (Fig. 7-2). Later in 
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the logger settings only the channels are shown which are being 
acquired with the corresponding sample rate.

Fig. 7-2 Selection of the sample rate, FastSampleRate and 
SlowSampleRate illustrated (you define the names when 
setting the sample rate).

➡ You should only use one sample rate per UART for all modules, 
especially with analog signals. Two sample rates which are to 
operate through one UART (one bus system) may otherwise lead 
to (small) inaccuracies in the time pattern of the measurements. 
If required, you can write individual modules to a different logger 
at a reduced data rate (logging rate). However, the data buffer 
should be filled with the same sample rate for all modules of a 
UART. If in doubt, use the higher sample rate for all modules of a 
UART.

7.3 Logger settings

The data loggers store the acquired values in one or more files. 
The storage speed (Logging rate) need not necessarily be the 
same as the sample rate. The files can be saved internally or 
externally and you can also set that the storage medium can be 
changed during the measurement. Refer also to Section 7.4, 
Examples page 93ff.

You call the logger settings via the context menu of the Test Con-

troller or via .

Create further loggers, 

delete loggers

At least one logger is always present and you can create others 

with a click on  above in the window. A maximum of 20 log-

gers is possible. A click on  deletes the relevant logger with all 
the settings (for safety you are queried again before deletion).

UART 2

UART 3
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Fig. 7-3 Logger settings (example of a continuous logger).

7.3.1 Settings in the header section for Loggers 1 to 20

Data source Here you select which sample rate (which data buffer) is to be 
used for this data logger. You choose how many values are actu-
ally stored via Logging rate; refer below.

IMPORTANT
The selection of any other data source resets all settings of the 
logger (right side).

Logger type Here, you choose between Continuous, Triggered and Event-
based. After selecting Triggered or Event-based other options 
are displayed so that you can set the trigger conditions.
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Fig. 7-4 Logger type Triggered.

You will find the special settings for triggered or event-based 
measurements in Section 7.3.5, page 90; the settings applicable 
to both logger types are explained in the following sections.

Logger name We recommend that a name is assigned which characterizes the 
purpose of the logger, e.g. SlowMeasurement or ForceTrigger.

Using placeholders in the logger name, you can define a suitable 
folder structure for your files. Specifying %YYYY-%mm-%dd/
%HH/SlowMeasurement creates the following folder structure 
if the first measurement of the first file was acquired at 8am on 
25.01.2014:
\2014-01-25\08\SlowMeasurement…

Available placeholders

Place-
holder

Meaning Example

%a Day of the week, abbreviated Thu

%A Day of the week Thursday

%b or %h Month name, abbreviated Aug
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%B Month name August

%c Date and time
Thu Aug 
13:55:02 2014

%C
The first two places of the year 
figure

20

%d Day with two figures 23

%D Date in short form 02/23/14

%e
Day with two places
(space character as prefix)

 1

%F Date (long form) 2014-02-23

%g
The last two places of the year 
figure, week-based

14

%G Year figure, week-based 2014

%H Hour in 24-hour format 13

%I Hour in 12-hour format 01

%j Day of the year 235

%m Month with two figures 02

%M Minute 55

%p AM or PM PM

%r Time in 12-hour format 01:55:02 pm

%R Time in 24-hour format 13:55

%S Seconds 02

%T Time to ISO 8601 1:55:02 PM

%u
Day of the week to ISO 8601 
(Monday = 1)

4

%U
Calendar week with Sunday of 
the first week = 1

33

%V Calendar week to ISO 8601 34

%w
Day of the week as number 
with Sunday = 0

4

%W
Calendar week with Monday of 
the first week = 1

34

Place-
holder

Meaning Example
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Logger status To use the logger with the following stated conditions you have to 
select Activated here (default setting). If the option is not active, 
the start/stop trigger is not evaluated. You can then activate or 
deactivate the logger status, for example, using the arithmetic 
function InternalLoggerControl. The logger status can also be 
changed via the Expert settings; refer to Status, Section 7.3.4, 
page 89.

7.3.2 Available variables

All channels which operate with the sample rate selected at Data 
source are displayed. Select those which are to be recorded by 
this logger.

Create statistics or arithmetic channels

If you do not want to record all values, but rather only statistical 
values such as minimum or maximum, etc., open the context 
menu for the variables (for the channel) and select the required 
value. Add statistical values generates all possible values (min/
max/mean and the standard deviation) as subchannels. Blank 
arithmetic generates a computation channel (formula). You have 
the same functions available as with the virtual variables; refer 
also to Section 6.4, Virtual variable, page 59.

Double click on the new channel to define the settings (Fig. 7-5).

%y
The last two figures of the year 
figure

14

%Y Year figure 2014

%z
Time offset with respect to 
UTC time according to ISO 
8601 in minutes

+100

%Z
Time-zone name or abbrevia-
tion

CDT

%% Percent character %

Place-
holder

Meaning Example
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Fig. 7-5 Dialog for the functions Maximum and Reset.

If you have created a blank formula, click in the field to the right 
of Formula to call the input dialog. For the Max function illus-
trated in Fig. 7-5 you can either define that a variable or a digital 
input controls the reset (the variable ResetMinMax in the illus-
tration) or that the value is reset after being stored at the logging 
rate (In the storage interval:). Yes). In this case the logging 
rate should be significantly lower than the sample rate. If neces-
sary, create a dedicated logger for such values; refer also to the 
next section.

Example: Maximum function, sample rate 3000 Hz, logging rate 
5 seconds. With this setting the maximum is formed over 15,000 
measurements in each case and is then stored (1 value).

7.3.3 Details in the record settings section

You will find the special settings for triggered or event-based 
measurements in Section 7.3.5, page 90; the settings valid for 
both logger types are explained in the following.

7.3.3.1 Logging rate

Here, you can define whether all values acquired with the sample 
rate specified under Data source (refer to Sample rate #1 to #4, 
page 76) are to be written into the data buffer or, for example, 
only every 10th value. A value greater than the sampling fre-
quency is not permissible.

➡ The sample rate should be an integer multiple of the logging rate. 
For example, with a sample rate of 1000 Hz select a logging rate 
of, for example, 100, 200, 250, 500 or 1000 Hz, not however 300, 
400 or 750 Hz.

Select either Hz and enter the sampling frequency specified for 
the sample rate or enter a value lower than the sampling fre-
quency. In order to store only every 10th value, enter 400 Hz for 
a logging rate (sampling frequency) of 4000 Hz.
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If you only require a few values, e.g. you only want to save one 
value every ten seconds, specify Seconds for Logging rate and 
10 for Value.

7.3.3.2 Size of a single file

Depending on the logger type, you can specify the size of a file as 
the number of data records, in seconds, bytes or as a number of 
events. A data record corresponds to one measurement over all 
channels activated at Available variables. When the specified 
value is reached, a new file is started if the recording has not yet 
finished.

IMPORTANT
Up to 10,000 files can be saved on a storage medium.

➡ If you specify the file size as “rounded” time, the individual files 
are started at rounded times (rounding time feature). For exam-
ple, if the first recording starts at 13:33:43 h and 150 seconds 
(2.5 minutes) are recorded, then writing to the first file only takes 
place up to 13:36:00 h and then a new file is started, so that all 
other files start at “rounded” times (13:38:30 h, 13:41:00 h, etc.). 
This is also taken into account with a specification in minutes. 
However, if you specify, for example, 55 seconds, “rounding” 
does not take place to 60 seconds, i.e. “non-rounded” starting 
times occur.

The file name is formed from the logger name and the date and 
time of the first measurement. Using placeholders in the logger 
name, you can define a suitable folder structure for your files; 
refer to Logger name, page 81.

7.3.3.3 Event length

This setting is only available with the Event-based logger type.

You define over how many data records, how long or how many 
bytes per event are to be logged. A data record corresponds to 
one measurement over all channels activated at Available vari-
ables.

7.3.3.4 Storage length

This setting is only available with the Triggered logger type.

You specify the total time over which logging is to occur. The set-
ting is independent of the size of the single file, i.e. it can be 
smaller or larger. If the value for the Storage length is greater 
than the size of the single file, then several files are written.
Refer also to Section 7.4, Examples.
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7.3.3.5 Type of storage

The type of storage determines how and in what sequence writ-
ing occurs to the target memories specified in the following. Now 
you have basically four options:

1. Storage on the newly connected data medium

Storage of the data occurs on the first available data medium 
with the file size specified under Size of a single file. If no 
further space is available here, the oldest two files are deleted 
and overwritten with new data (one file more is always 
deleted than written new in order to maintain a reserve).
When you connect a second data medium, the storage on the 
active data medium is terminated immediately and is written 
to the new data medium. You can remove the old data 
medium once the blue LED (RUN) no longer flashes rapidly 
(storage has then terminated). Otherwise the copied files may 
be damaged, refer also to Section 4.4.1.2, Storage to external 
memory running, page 21. This means that you can write 
alternately to two storage media, e.g. an SD card and a USB 
storage medium.

2. Automatic drive selection

Storage of the data occurs on the first available data medium 
in the list with the file size specified under Size of a single 
file. If no further space is available here, the next data 
medium in the list is used. If all available data media are full, 
the oldest two files in all data media are sought. They are then 
deleted and the relevant data medium is used further. The 
oldest files of this data medium are always deleted and over-
written with new data (one file more is always deleted than 
written new in order to maintain a reserve). With this option 
all the specified data media are used like a single large ring 
buffer.
To prevent the loss of data you have to read out the data via 
the network before overwriting.

3. Moving files

Storage of the data occurs on the specified data medium with 
the file size specified under Size of a single file. If no further 
space is available here, the oldest two files on this data 
medium are deleted and overwritten with new data (one file 
more is always deleted than written new in order to maintain 
a reserve).
When you connect another data medium, the data are moved 
onto this data medium, i.e. they are deleted on the original 
data medium. The transfer is indicated by rapid flashing of 
the blue LED (RUN). You can remove the data medium once 
the blue LED no longer flashes rapidly. Otherwise the copied 
files may be damaged, refer also to Section 4.4.1.2, Storage to 
external memory running, page 21.
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4. Copying files

Storage of the data occurs on the specified data medium with 
the file size specified under Size of a single file. If no further 
space is available here, the oldest two files on this data 
medium are deleted and overwritten with new data (one file 
more is always deleted than written new in order to maintain 
a reserve).
When you connect another data medium, the data are copied 
onto this data medium, i.e. they are retained on the original 
data medium and are not deleted as in the case of 3. With the 
selection of ... only new data only the data which has not yet 
been copied are copied onto the newly connected data 
medium.
The copying process is indicated by rapid flashing of the blue 
LED (RUN). You can remove the data medium once the blue 
LED no longer flashes rapidly. Otherwise the copied files may 
be damaged, refer also to Section 4.4.1.2, Storage to external 
memory running, page 21.

Protected mode

The protected mode prevents unauthorized reading of your data. 
For this you require a specially prepared data medium which is 
coded to the Q.station and the data medium used. In this matter 
contact the Technical Support (refer to Chapter 9, International 
Sales and Service, page 111), who will then produce an appropri-
ate file for your storage medium using the details you provide. 
After selecting this option, the data are only transferred when a 
data medium coded in this way is connected. No data is trans-
ferred when another data medium is connected.

7.3.3.6 Target memories

Storage of the data always takes place on the specified data 
medium or on the first available medium where there are several 
media. The maximum size of the internal memory (hd0) is 
1 Gbyte.

➡ However, we recommend that the internal memory is only used 
with low data rates, because here the number of measurements 
which can be saved per second is relatively low.

Otherwise select a fast SD card, a USB drive or a network drive.

IMPORTANT
Up to 10,000 files can be saved on a storage medium.

Whether and when writing to further media occurs depends on 
the settings for Type of storage.
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IMPORTANT
If only one medium is specified, this medium must not be 
removed as long as one of the loggers is active. Otherwise data 
may be lost. With storage on USB make sure that the correct USB 
interface is specified (refer to Fig. 4-1, page 17). 

To facilitate the connection of several USB data media via a USB 
hub you can select various ports for the relevant USB interface.

If, as in Section 6.1.3.4, Network drives, page 50, you have 
defined one or several network drives, you can also define them 
as the target memory: select the Name specified there.

7.3.3.7 Also send data to FTP server

In order to be able to send data to an FTP server, you must first 
define the data for the FTP server(s); refer to Client settings in 
Section 6.1.3.3, page 49. The data are sent when the Size of the 
single file is reached.

Here, you select the FTP server.

Fig. 7-6 Send data to an FTP server

Tip
Using the variable SendFTPVirtualBufferFile, you can also trig-
ger the sending of a file to an FTP server. In this case you can 
leave the entry blank. 

7.3.3.8 Sending an e-mail

In order to be able to send e-mails you must define the possible 
selections for the fields Address, Subject and Content; refer 
also to Section 6.1.3.6, page 51. The e-mail is sent when the Size 
of a single file is reached; the file is sent as an attachment.
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Make selection

You call the logger settings via the context menu of the Test Con-

troller or via .

Fig. 7-7 Sending an e-mail.

Activate Additionally send e-mail and select one of the settings 
for the Address, Subject and Content.

7.3.4 Expert settings

With the expert settings you can perform various general settings 
for any data logger. The default settings are suitable for most 
applications, so only change them if necessary.

Fig. 7-8 Expert settings.

File storage mode The buffered setting offers the fastest speed, but the operating 
system decides when writing is to occur. In the settings with 
direct, writing takes place directly without a buffer where possi-
ble, sync synchronizes the complete file system directly after 
every time writing to a file occurs (directory structure) and fsync 
only synchronizes the written file (updating where the file is 
located on the storage medium).

Status This basically corresponds to the setting of the logger status 
(Section 7.3.1, Logger status, page 83). In the Single shot mode 
the logger is only activated once at the trigger event. Depending 
on the setting for the file size, several files are also recorded as 
long as the trigger event is present. After recording, the logger is 
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deactivated in this mode and another trigger event is not 
awaited.

➡ You can also activate or deactivate the logger (again) in the Sin-
gle shot mode via the arithmetic function InternetLoggerCon-
trol. 

Maximum files This defines how many files can be created as a maximum by this 
logger (0 to 4,294,967,295). The default setting is 10,000.

Maximum bytes With this setting you can restrict the space in bytes available to 

this logger (0 to approx. 1.8 ⋅ 1019, longest 64-bit integer num-
ber). Specifying 0 (default setting) corresponds to no restriction.

Maximum files in the direc-

tory

This restricts the number of files which can be created in a direc-
tory. The default setting is 10,000.

Automatic file deletion This deletes the oldest files once the space available on the stor-
age medium has been occupied.

7.3.5 Trigger and event settings

IMPORTANT
You must measure the channel used for the trigger condition or 
the event or the condition variable with the logger sample rate 
(same sample rate). The channel must therefore be listed and 
activated in the section Available variables.

The difference between Event-based and Triggered is that with 
Triggered both start and stop occur via a trigger event, whereas 
with Event-based only the start is initiated by an event (trig-
gered) and a stop trigger does not exist: The quantity of data 
specified under Event length is always recorded.

Start-trigger, event You can specify a channel or a computation as the Condition for 
the trigger. This can also be a channel, for which writing into the 
variable occurs, e.g. via EtherCAT from a PLC or from test.con. 
Click on the entry field to call the dialog for input. The field is dis-
played with a red font as long as no condition or an invalid one is 
specified. Specify whether the variable has to exceed (>), under-
cut (<), be greater than or equal to (>=), be less than or equal to 
(<=), be identical to (==) or only not the same as (!=) the speci-
fied value, so that the trigger or event is initiated.

IMPORTANT
The start trigger must also be recorded.
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Stop-trigger Click on Stop trigger to change over between Condition and 
None. In the None setting storage is terminated when the stor-
age length is reached.

You can specify a channel or a computation as the Condition. 
This can also be a channel, for which writing into the variable 
occurs, e.g. via EtherCAT from a PLC or from test.con. Click on 
the entry field to call the dialog for input. The field is displayed 
with a red font as long as no condition or an invalid one is speci-
fied. Specify whether the variable has to exceed (>), undercut 
(<), be greater than or equal to (>=), be less than or equal to 
(<=), be identical to (==) or only not the same as (!=) the speci-
fied value, so that the trigger is initiated.

IMPORTANT
The stop trigger must also be recorded.

Pre-trigger Using a pre-trigger you can define that a certain time is also 
recorded before the occurrence of the above defined start event. 
The figure can be given in seconds or as a number of data 
records. Click on Pre-trigger to switch the option on or off.

IMPORTANT
The pre-trigger must fit into the buffer specified for the sample 
rate; refer to Buffer size, page 78.

When you specify a pre-trigger, values are continuously recorded 
in the internal memory. If the condition is fulfilled, the data pres-
ent here is stored in the logger file.

Post-trigger Here specify whether recording is to continue after the stop sig-
nal. The figure can be given in seconds or as a number of data 
records. Click on Post-trigger to switch the option on or off.

IMPORTANT
With repeated measurements the pre-trigger condition is only 
evaluated again after the post-trigger has run.

Event length This setting is only available with the Event-based logger type.

You define over how many data records, how long or how many 
bytes per event are to be logged. A data record corresponds to 
one measurement over all channels activated at Available vari-
ables.
Refer also to Section 7.4, Examples.

Storage length This setting is only available with the Triggered logger type.
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You specify the total time over which logging is to occur. The set-
ting is independent of the size of the single file, i.e. it can be 
smaller or larger. If the value for the Storage length is greater 
than the size of the single file, then several files are written.
Refer also to Section 7.4, Examples.
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7.4 Examples

The following includes configuration examples for frequently 
occurring measurement tasks.

7.4.1 Continuous recording

7.4.1.1 Storage on a data medium, storage with or without data reduction

Continuous recording of all data is to take place. The values 
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate 
of 10 Hz (ten values per second) over 300 seconds in each case. If 
the set sample rate #1 (StandardMeasuringRate) is higher than 
the logging rate, data reduction occurs. A logging rate higher 
than the sample rate is not permissible. Each file contains 3000 
values per channel (300 seconds at 10 Hz, Fig. 7-9).

Fig. 7-9 Example of a continuous recording.
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The data are written to the SD card and must therefore be moved 
from time to time from there to a different medium, e.g. via the 
network. Otherwise, the two oldest files are deleted and overwrit-
ten with new data (one file more is always deleted than written 
new in order to maintain a reserve).

7.4.1.2 Storage on several data media, storage with or without data reduc-
tion

Continuous recording of all data is to take place. The values 
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate 
of 10 Hz (ten values per second) over 300 seconds in each case. If 
the set sample rate #1 (StandardMeasuringRate) is higher than 
the logging rate, data reduction occurs. A logging rate higher 
than the sample rate is not permissible. Each file contains 3000 
values per channel (300 seconds at 10 Hz, Fig. 7-10, page 95).

The data are first written to the SD card, then to the storage 
medium on USB1 and finally to the storage medium on USB2 
(refer to Fig. 4-1, page 17). If all available data media are full, the 
oldest two files are sought. In the example they are located on the 
SD card and are then deleted. Thereafter, the SD card continues 
to be used; the oldest files of this data medium are always deleted 
and overwritten with new data (one file more is always deleted 
than written new in order to maintain a reserve). When all files 
have been overwritten once, the next target memory is used, here 
the storage medium on USB1.

With this option all the specified data media are used like a single 
large ring buffer. To prevent the loss of data you have to read out 
the data via the network before overwriting.
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Fig. 7-10 Continuous recording on several data media.

7.4.1.3 Storage on last connected data medium, storage with or without 
data reduction

Continuous recording of all data is to take place. The values 
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate 
of 10 Hz (ten values per second) over 300 seconds in each case. If 
the set sample rate #1 (StandardMeasuringRate) is higher than 
the logging rate, data reduction occurs. A logging rate higher 
than the sample rate is not permissible. Each file contains 3000 
values per channel.
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Fig. 7-11 Example of a continuous recording (USB1 is the left USB 
interface; refer to Fig. 4-1, page 17).

The data are written to the first available storage medium (to the 
Fig. 7-11 SD card or USB storage medium). You must therefore 
promptly connect the second medium specified as the target 
memory. Otherwise, the two oldest files are deleted and overwrit-
ten with new data (one file more is always deleted than written 
new in order to maintain a reserve).

When you connect the second storage medium (Target mem-
ory), storage on the current medium is terminated, i.e. normally 
a file containing less than 300 seconds is produced. The blue LED 
(RUN) on the Q.station flashes rapidly until the write process 
starts on the new medium. With larger storage media detection 
may take longer, so it is essential to wait until the LED starts to 
flash rapidly. When the blue LED flashes slowly again (this may 
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take longer than a minute), you can and must remove the first 
storage medium. Remove the data medium only when the flash-
ing has stopped as otherwise the files may be damaged. The 
changeover from one storage medium to the next takes place 
when you connect a new medium.

7.4.2 Recording of a single event (repeated)

7.4.2.1 Control by start/stop condition and time limitation, storage on one 
data medium, transfer on connection of another one

Recording is to occur when the variable Start&Stop_Cond. is 
greater than 0.5 (the variable is a digital input and contains the 
value 0 or 1). Overall, measurement should occur until the vari-
able Start&Stop_Cond. is again smaller than 0.5 or until 30 min-
utes have been recorded. Recording should take place at 10 Hz.

With the settings from Fig. 7-12, page 98 the recording starts 
when the variable Start&Stop_Cond. is greater than 0.5. As long 
as this is the case, a file is produced at 10 Hz for each time for a 
maximum of 5 minutes (Size of a single file) and then a new file 
is started. When the variable Start&Stop_Cond. is smaller than 
0.5 or after 30 minutes at the latest (Storage length 1800 sec-
onds), the recording is stopped, i.e. the file last produced is gen-
erally smaller than 300 seconds.

When a new start-trigger then occurs, i.e. when the variable 
Start&Stop_Cond. is again greater than 0.5, the recording starts 
again.

The data are written to the SD card (Target memory). You must 
therefore promptly connect another storage medium, e.g. a USB 
data medium. Otherwise, the two oldest files are deleted and 
overwritten with new data (one file more is always deleted than 
written new in order to maintain a reserve). When you connect 
another storage medium, the transfer of the files begins. The blue 
LED (RUN) on the Q.station flashes rapidly until the write pro-
cess on the new medium has concluded. With larger storage 
media this process and also the detection of the storage medium 
may take longer, so it is essential to wait until the LED starts to 
flash rapidly. Once the blue LED flashes slowly again, you can 
remove the data medium (e.g. tap Eject on the display). Remove 
the data medium only when the flashing has stopped as otherwise 
the files may be damaged.
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Fig. 7-12 Example of a triggered recording with time limitation.

7.4.2.2 Start and stop a measurement with pre- and post-trigger, storage 
on one data medium, transfer on connection of another one

Recording is to occur when the variable Start&Stop_Cond. is 
greater than 0.5 (the variable is a digital input and contains the 
value 0 or 1). However, the recording is to start before this event 
and the recording should also contain the measurements of 30 
seconds before this event. Measurement should continue overall 
until the variable Start&Stop_Cond. is again less than 0.5 plus a 
run-on period of one minute. The other recording parameters are 
as given in the previous example.
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Fig. 7-13 Example of a triggered recording with start and stop trig-
ger.

With the settings from Fig. 7-13, page 99 the values to be stored 
are initially written to an intermediate buffer which is 30 seconds 
in size, i.e. it contains 300 measurements per channel. When the 
variable Start&Stop_Cond. is greater than 0.5, this buffer is writ-
ten to a file. (If the time for the pre-trigger is greater than the 
Size of a single file, then several files are written.) Thereafter, 
a file is produced with 10 Hz in each case over 300 seconds and 
then a new file is started. When the variable Start&Stop_Cond. is 
less than 0.5, the recording continues for a further 60 seconds 
and, where necessary, a new file is also started.

At the end of the measurement storage occurs again in an inter-
mediate buffer and when a new start trigger occurs, i.e. when the 
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variable Start&Stop_Cond. is again greater than 0.5, the record-
ing starts again.

IMPORTANT
The start condition is only checked again when the post-trigger 
has terminated. If the start condition is fulfilled before the pre-
trigger has expired, recording is started immediately.

The data are written to the SD card (Target memory). You must 
therefore promptly connect another storage medium, e.g. a USB 
data medium. Otherwise, the two oldest files are deleted and 
overwritten with new data (one file more is always deleted than 
written new in order to maintain a reserve). When you connect 
another storage medium, the files so far created on this medium 
are moved, i.e. they are deleted from the SD card after being 
written on the new storage medium. The blue LED (RUN) on the 
Q.station flashes rapidly until the write process on the new 
medium has terminated. With larger storage media this process 
and also the detection of the storage medium may take longer, so 
it is essential to wait until the LED starts to flash rapidly. When 
the blue LED flashes slowly again (this may take longer than a 
minute), you can remove the (last connected) storage medium. 
Remove the data medium only when the flashing has stopped as 
otherwise the copied files may be damaged. Storage of the cur-
rent measurements continues in the background during the 
transfer.

7.4.2.3 Event-based recording with pre-trigger and storage on a network 
drive

Recording is to occur when the variable Start_Cond. is greater 
than 0.5 (the variable is a digital input and contains the value 0 or 
1). Overall, each event is to be recorded with 10 seconds pre-trig-
ger and 30 seconds subsequent post-trigger (event length). 
Recording should take place at 1000 Hz.

Using the settings in Fig. 7-14 the pre-trigger buffer is initially 
filled. When the variable Start_Cond. is greater than 0.5, this buf-
fer is written to a file along with the following 30 seconds. 
Recording takes place in each case at 1000 Hz for 40 seconds. 
Thereafter the pre-trigger buffer is filled again and the event 
awaited. Once the specified 50 events have been recorded, the 
file is closed and a new one started.
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Fig. 7-14 Event-based measurement.

The data are written to the network drive which you have speci-
fied in the basic settings using Host interface > Network 
drive. In this respect refer to Chapter 6, Basic configuration of 
your system, page 41, and Section 6.1.3.4, page 50.

7.4.3 Angular synchronous measurement

Carry out the basic setting for this measurement using the con-
text menu Settings of the Test Controller (Fig. 7-15).
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Fig. 7-15 Example of an angular synchronous measurement.

The signal from the rotary sensor (360 pulses/revolution) is fed 
into DI2. The sensor has a zero index signal (pulse-shaped) which 
is fed into DI3. The maximum rotational speed is below 
20,000 rpm, i.e. at least three milliseconds must pass before the 
next pulse can come.

The settings for the logger take place as in the other examples.
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8 Access to data in the 
Q.station

You have several ways of reading out data from the Q.station or 
of operating the Q.station remotely.

1. From your PC you can access the Q.station drives, e.g. the 
internal memory hd0, through a network and SMB/CIFS.

2. You can remotely control the Q.station through VNC, e.g. 
using a VNC viewer.

3. You can transfer the data from the Q.station to an FTP server; 
refer to FTP client in Section 6.1.3.3, page 49.

8.1 Access through SMB/CIFS

Enter the IP address of the Q.station on your PC in the search box 
(Fig. 8-1) and press Return.

Fig. 8-1 Entering the IP address.

The Q.station then appears with the IP address in the list of net-
work drives or PCs (Fig. 8-2 on page 104).
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Fig. 8-2 Q.station as network drive.

You must enter the user name and password to be able to access 
the data. To do this, open the entry (the Data directory is shown) 
and double click on this directory (Fig. 8-3).

Fig. 8-3 Data directory on the Q.station.

In the following dialog enter the user name (data) and password 
(ginsdata). Use data as password for older controllers with firm-
ware 1.xx B0x.
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➡ Note that Windows assumes that you want to log onto the current 
domain (if you are a member of a domain). In this case you must 
specify \data to bypass the prefixed domain (Fig. 8-4).

Fig. 8-4 Login dialog.

Then you are shown the internal memory as hd0 (Fig. 8-5).

Fig. 8-5 Internal memory of the Q.station as network drive.

You can now access the drive just like any other network drive 
and copy or move files, etc.

Alternatively you can also select the menu Extras -> Connect 
network drive in any Explorer window (Fig. 8-6).
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Fig. 8-6 Linking the Q.station as Drive Q.

Then, you obtain, as in the first case, the login dialog (Fig. 8-4), in 
which you have to enter the user name data) and password 
(ginsdata). Use data as password for older controllers with firm-
ware 1.xx B0x. Then the internal memory is shown as hd0 on the 
drives of your PC.

Fig. 8-7 Drive Q contains the internal memory hd0.

Now you can also directly access (with both methods) the data 
directly with test.viewer and test.node. With test.node you can 
even check the logger settings.
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8.2 Remote control by VNC

The following section explains how you set up a remote control 
using TightVNC in order to be able to operate the display of a 
Q.station D or DT using the PC.

Download the program TightVNC (freeware under GNU General 
Public License Version 2) to your computer.
http://www.tightvnc.com/download.php.

➡ Note that the various installation programs depend on the oper-
ating system.

Then install the program (refer to Fig. 8-8 for an example).

Fig. 8-8 Installing TightVNC.

You only need the TightVNC Viewer to be able to remotely oper-
ate the Q.station. For this use the installation type Custom 
(Fig. 8-9).
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Fig. 8-9 Custom installation.

You then have the possibility of installing the TightVNC Viewer 
(Fig. 8-10).

Fig. 8-10 Installing the viewer.

Follow the further instructions of the installation program.

After installation start the program and enter the IP address of 
the Q.station (Fig. 8-11).
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Fig. 8-11 Logging onto the Q.station.

In the next dialog enter the password master (Fig. 8-12).

Fig. 8-12 Entering the password.

Then the display on the screen is shown in a window and you can 
operate the Q.station by clicking on the fields as with tapping on 
the display (Fig. 8-13).
Q.series
Gantner Instruments GmbH 109



8     Access to data in the Q.station → Remote control by VNC
Fig. 8-13 Display of the Q.station in TightVNC

Of course, you can also use other VNC viewers. Enter the login 
data used above at the appropriate points.
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9 International Sales and 
Service

The current addresses of our sales partners can be found in the 
Internet on our web site. You can take up direct contact with 
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
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